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ÉÉDDIITTOORRIIAALL

BIENVENUE DANS CE NOUVEAU NUMÉRO DU MAGAZINE FULL CIRCLE

Comme toujours, il y a les tutoriels habituels, Python, Inkscape, Krita et Rawtherapee, accompagnés de la 
deuxième partie de la nouvelle série sur la création de podcasts sous Linux.

Nos lecteurs de longue date sauront que la première fois que j’ai côtoyé Linux, c’était avec Kubutu et KDE 
(3.5) il y a bien longtemps. Je l’ai abandonné quand KDE 4.0 est arrivé (inutilisable), y suis retourné brièvement 
quand il s’est stabilisé  à la version 4.5 ; mais suis à nouveau parti quand Plasma 5 s’est présenté, car il n’y avait 
pas d’interface graphique pour ma tablette graphique. Eh bien, il y a deux ou trois semaines, j’ai décidé 
d’essayer le tout dernier Live DVD de Kubuntu. En souvenir du bon vieux temps. Et, comme par hasard, ils ont 
ajouté l’interface graphique pour tablette graphique qui manquait ! Je ne suis pas certain de quand ça a été 
ajouté, mais j’ai dûment installé Kubuntu 20.04.1 et je suis heureux d’y être à nouveau. Je ne sais toujours pas 
pourquoi, ils ont rapidement abandonné KDE 4 pour Plasma 5. J’espère simplement qu’ils n’abandonneront 
pas Plasma 5 soudainement, maintenant que je l’ai installé.

Un problème que j’ai rencontré après l’installation de Kubuntu 20.04.1, était qu’il n’y avait pas de son. J’ai 
essayé toutes les solutions possibles et imaginables. Je voyais (dans Pavucontrol) que le son était produit, 
puisque la petite barre sautait vers le haut et vers le bas en même temps que le son était inaudible. Il m'a fallu 
plusieurs jours de réflexion avant de trouver la solution. Il s’avère que mon PC a deux jacks de sortie et 
Kubuntu avait décidé d’utiliser l’autre. Je n’ai trouvé le deuxième jack qu’en crapahutant sur les genoux sous 
mon bureau avec une lampe de poche. Tiens, je dois sortir l’aspirateur…

Soyez prudent et en bonne santé !

Amitiés et restons en contact,

Ronnie
ronnie@fullcirclemagazine.org

MÉCÈNES FCM : https://www.patreon.com/fullcirclemagazine
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AACCTTUUSS

Le langage de programmation Julia 
1.5 est sorti. Il associe des qualités 

comme une performance remarquable, 
le support de la dactylographie dyna-
mique et des outils intégrés pour une 
programmation parallèle. La syntaxe de 
Julia est similaire à celle de MATLAB 
avec des éléments de Ruby et Lisp. La 
méthode de manipulation de chaînes 
ressemble à celle de Perl. Le code du 
projet est distribué sous une licence 
du MIT.

https://julialang.org/blog/2020/08/
julia-1.5-highlights

LE PROJET OPENSSF 
A ÉTÉ ÉTABLI
03/08/2020

L a Linux Foundation a annoncé la 
création d'un nouveau projet con-

joint, la OpenSSF (la Open Source Se-
curity Foundation), avec pour objectif 
de rassembler les travaux des leaders 
dans le domaine de l'amélioration des 
logiciels Open Source. La OpenSSF con-
tinuera de développer des initiatives 
telles que la Core Infrastructure Initia-
tive et la Open Source Security Coalition 

et rassemblera d'autres travaux sécu-
ritaires entrepris par des sociétés qui 
ont rejoint le projet. Le travail de la 
OpenSSF se concentrera sur des do-
maines comme la divulgation coor-
donnée des vulnérabilités et la distri-
bution des correctifs, le développement 
d'outils de sécurité, la publication des 
meilleures pratiques du développement 
sûr, l'identification de menaces sécuri-
taires dans les logiciels Open Source, 
des vérifications et le durcissement des 
projets Open Source critiques, la créa-
tion d'outils pour la vérification de 
l'identité des développeurs.

https://www.linuxfoundation.org/
press-release/2020/08/technology-
and-enterprise-leaders-combine-
efforts-to-improve-open-source-
security

PUBLICATION DE MASTODON 3.2
04/08/2020

L a plateforme libre pour le déploie-
ment de réseaux sociaux décentra-

lisés, Mastodon 3.2, est sortie. Elle vous 
permet de créer des services dans vos 
propres établissements qui ne soient 
pas contrôlés par les fournisseurs indi-

viduels. Si l'utilisateur n'arrive pas a 
démarrer son propre nœud, il peut choi-
sir un service public digne de confiance 
pour se connecter. Mastodon appar-
tient à la catégorie de réseaux fédé-
rés, qui se servent de la suite proto-
colaire ActivityPub pour créer une seule 
structure de communication.

Le côté serveur du projet est écrit 
en Ruby avec Ruby on Rails, tandis que 
l'interface client est écrite en Java-
Script avec les bibliothèques React.js 
et Redux. Le code source est distribué 
sous licence AGPLv3.

https://blog.joinmastodon.org/
2020/08/mastodon-3.2

LANGAGE DE PROGRAMMATION 
VALA 0.49.1
04/08/2020

Une nouvelle version du compilateur 
pour le langage de programma-

tion Vala 0.49.1 est publiée. Le langage 
Vala fournit une syntaxe similaire à C# 
et Java, ainsi qu'une intégration facile 
avec des bibliothèques écrites en C, les 
deux se servant du Glib Object System 

(Gobject) et il peut être autonome.

https://www.mail-archive.com/
release-team@gnome.org/
msg08542.html

PUBLICATION DU NAVIGATEUR 
PALE MOON 28.12
04/08/2020

Le navigateur Web Pale Moon 28.12 
est sorti ; il s'agit d'un fork de la 

base de code de Firefox pour fournir 
de meilleures performances, préserver 
l'interface classique, minimiser l'usage 
de la mémoire et fournir des options 
de personnalisation supplémentaires. 
Les binaires de Pale Moon sont cons-
truits pour Windows et Linux (c86 et 
x86_64). Le code du projet est distri-
bué sous licence MPLv2 (Mozilla Public 
License).

https://forum.palemoon.org/
viewtopic.php?t=24954&p=196294

Soumises par ErikTheUnready

https://julialang.org/blog/2020/08/julia-1.5-highlights
https://www.linuxfoundation.org/press-release/2020/08/technology-and-enterprise-leaders-combine-efforts-to-improve-open-source-security
https://blog.joinmastodon.org/2020/08/mastodon-3.2
https://www.mail-archive.com/release-team@gnome.org/msg08542.html
https://forum.palemoon.org/viewtopic.php?t=24954&p=196294
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ACTUS
LE CORRECTIF DE BOOTHOLE 
A ÉTÉ CORRIGÉ
05/08/2020

Les distributions Linux majeures ont 
publié une mise à jour corrective 

au paquet GRUB2 pour traiter des pro-
blèmes qui se sont révélés depuis la 
vulnérabilité BootHole. Après avoir ins-
tallé la première mise à jour, certains 
utilisateurs ne pouvaient plus démar-
rer leur système. Les problèmes de 
boot ont eu lieu sur des systèmes avec 
BIOS ou UEFI en mode « Legacy » et 
étaient causés par des changements 
régressifs, dans des situations précises, 
qui menaient au plantage pendant le 
processus du démarrage ou une défi-
nition incorrecte du dispositif boot et 
l'installation incorrecte du bootloader 
(chargeur de démarrage).

https://lists.ubuntu.com/archives/
ubuntu-security-announce/2020-
August/005549.html

FEDORA 33 
LANCE UNE RÉVISION OFFICIELLE 
DES OBJETS CONNECTÉS

Peter Robinson, de l'équipe de Red 
Hat Release Engineering, a publié 

une proposition concernant l'adoption 

d'options pour l'IoT (les objets connec-
tés) dans l'édition officielle de Fedora 
33. Ainsi, à partir de Fedora 33, la ver-
sion IoT sera livrée sur un pied d'éga-
lité avec Fedora et Fedora Workstation 
Server. La proposition n'est pas encore 
approuvée officiellement, mais sa pu-
blication a été approuvée auparavant 
par la FESCo (Fedora Engineering Stee-
ring Committee), qui est responsable 
de la partie technique du développe-
ment de la distribution Fedora et son 
acceptation peut être considérée com-
me une formalité. 

https://www.mail-archive.com/devel-
announce@lists.fedoraproject.org/
msg02341.html

LE SERVEUR COMPOSITE

 WAYFIRE 0.5 EST DISPONIBLE
05/08-2020 12:18

L a publication du serveur composite 
Wayfire 0.5, qui utilise Wayland et 

vous permet de créer des interfaces 
utilisateur qui économisent les res-
sources et proposent des effets 3D si-
milaires aux greffons 3D de Compiz 
(basculement entre des écrans au tra-
vers d'un cube 3D, une disposition spa-
tiale des fenêtres, le morphage quand 
on travaille avec des fenêtres), est sor-
tie. Wayfire supporte des extensions 

via des greffons et fournit un système 
de personnalisation flexible.

Le code du projet est écrit en C++ 
et distribué sous la licence du MIT. 
Pour la base, la bibliothèque wlroots 
est utilisée ; elle est développée par 
les développeurs de l'environnement 
utilisateur Sway et fournit les fonctions 
de base pour l'organisation d'un gestion-
naire composite basé sur Wayland. 
Comme panneau, vous pouvez utiliser 
wf-shell ou LavaLauncher.

https://wayfire.org/2020/08/04/
Wayfire-0-5.html

PUBLICATION 
DE LIBREOFFICE 7.0
05/08/2020

L a Document Foundation présente 
la publication de la suite bureau-

tique LibreOffice 7.0. Des paquets d'ins-
tallation tout faits sont disponibles pour 
diverses distributions Linux, Windows 
et macOS, ainsi que pour le déploie-
ment d'une version en ligne dans 
Docker. Dans cette version, 74 % des 
changements étaient faits par des res-
ponsables du projet tels que Colla-
bora, Red Hat et CIB et 26 % des chan-
gements étaient dus à la contribution 
de passionnés indépendants.

https://blog.documentfoundation.org/
blog/2020/08/05/announcement-of-
libreoffice-7-0

PINTA 1.7 EST SORTI
05/08/2020

C inq ans après la dernière version, la 
publication de l'éditeur graphique 

raster open Penta 1.7 est disponible 
au téléchargement. Il s'agit d'une tenta-
tive de réécrire le programme Paint.NET 
avec GTK. L'éditeur fournit un ensem-
ble de base de capacités de dessin et 
de traitement d'images, en ciblant des 
utilisateurs débutants. L'interface a été 
simplifiée autant que possible, l'édi-
teur supporte un tampon illimité de 
retour en arrière, vous permet de tra-
vailler avec des couches multiples et 
est équipé d'un jeu d'outils pour l'ap-
plication de divers effets et l'ajuste-
ment des images. Le code de Pinta est 
sous la licence du MIT. Le projet est 
écrit en C# avec Mono et la liaison 
avec GTK #. Des compilations binaires 
sont disponibles pour Ubuntu, macOS 
et Windows.

https://www.pinta-project.com/
releases/1-7

https://lists.ubuntu.com/archives/ubuntu-security-announce/2020-August/005549.html
https://www.mail-archive.com/devel-announce@lists.fedoraproject.org/msg02341.html
https://wayfire.org/2020/08/04/Wayfire-0-5.html
https://blog.documentfoundation.org/blog/2020/08/05/announcement-of-libreoffice-7-0
https://www.pinta-project.com/releases/1-7
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ACTUS

JEFFREY KNAUTH ÉLU NOUVEAU 
PRÉSIDENT DE LA FREE OPEN 
SOURCE FOUNDATION
06/08/2020

La Free Software Foundation a annon-
cé l'élection d'un nouveau président 

après le départ de Richard Stallman, 
suite à des allégations de comporte-
ment inapproprié pour le responsable 
d'un mouvement SPO et des menaces 
de rupture avec quelques-unes des or-
ganisations et communautés des logi-
ciels Open Source. Le nouveau président 
est Geoffrey Knauth, qui fait partie du 
conseil d'administration de la Free Soft-
ware Foundation depuis 1998 et est 
membre du GNU Project depuis 1985.

https://www.fsf.org/news/geoffrey-
knauth-elected-free-software-
foundation-president-odile-benassy-
joins-the-board

PUBLICATION  
D'UBUNTU 20.04.1 LTS
06/08/2020

C anonical a révélé la première ver-
sion corrective d'Ubuntu 20.04 LTS, 

la 20.04.1. Elle comprend des mises à 
jour de plusieurs centaines de paquets 
pour remédier à des problèmes de vul-

nérabilités et de stabilité. La nouvelle 
version corrige aussi des erreurs dans 
l'installeur et le chargeur de démar-
rage. La publication d'Ubuntu 20.04.1 
a signifié la stabilisation de base de la 
version LTS et les utilisateurs d'Ubuntu 
18.04 seront invités maintenant à met-
tre à niveau vers la branche 20.04.

En même temps, des mises à jour 
similaires sont disponibles pour Ubuntu 
Budgie 20.04.1 LTS, Kubuntu 20.04.1 
LTS, Ubuntu MATE 20.04.1 LTS, Ubuntu 
Studio 20.04.1 LTS, Lubuntu 20.04.1 
LTS, Ubuntu Kylin 20.04.1 LTS et Xu-
buntu 20.04.1 LTS. Le support de la 
publication des mises à jour et des 
correctifs de sécurité pour les éditions 
server et desktop d'Ubuntu 20.04 LTS 
durera jusqu'en avril 2025.

https://lists.ubuntu.com/archives/
ubuntu-announce/2020-August/
000259.html

LES TESTS DE PHP 8 BÊTA 
COMMENCENT
06/08/2020

L a première publication bêta de la 
nouvelle branche du langage de 

programmation PHP 8 est disponible 
afin que vous l'examiniez. Sa sortie est 
prévue pour le 26 novembre. En même 

temps, des versions de correction de 
bugs de PHP 7.4.9, 7.3.21 et 7.2.33 ont 
été faites.

https://www.php.net/archive/
2020.php#2020-08-06-3 

PILOTE VIDEO AMD 
RADEON 20.30
07/08/2020

A MD a publié un ensemble de pi-
lotes AMD Radeon 20.30 pour 

Linux basés sur le module libre AMD-
GPU core, pour les pilotes proprié-
taires et open-vidéo. Des piles de pilotes 
Open et propriétaires sont intégrées 
dans un ensemble AMD Radeon - des 
pilotes amdgpu-pro et amdgpu-all-open 
(le pilote Vulkan RADV et le pilote 
RadeonSI OpenGL basé sur du code 
de Mesa) sont proposés en un paquet 
et l'utilisateur peut choisir des pilotes 
open ou fermés.

https://www.amd.com/en/support/kb/
release-notes/rn-amdgpu-unified-
linux-20-30

PRÉSENTATION DE FIREFOX 
REALITY PC PREVIEW POUR LES 
DISPOSITIFS VR
07/08/2020

M ozilla présente une nouvelle ré-
vision du navigateur pour les sys-

tèmes de réalité virtuelle - Firefox Rea-
lity PC Preview. Le navigateur prend 
en charge toutes les fonctionnalités 
de respect de la vie privée de Firefox, 
mais offre une interface utilisateur 
différente en trois dimensions qui vous 
permet de naviguer entre des sites au 
sein du monde virtuel ou dans le cadre 
de systèmes de réalité augmentée. Des 
compilations sont disponibles à l'ins-
tallation en passant par le catalogue 
HTC Viveport (actuellement, unique-
ment pour Windows 10). Il fonctionne 
avec tous les casques 3D supportés 
par la plateforme Viveport, y compris 
les Vive Cosmos, Vive Pro, Valve Index, 
Oculus Rift et Oculus Rift S.

https://blog.mozvr.com/introducing-
firefox-reality-pc-preview

https://www.fsf.org/news/geoffrey-knauth-elected-free-software-foundation-president-odile-benassy-joins-the-board
https://lists.ubuntu.com/archives/ubuntu-announce/2020-August/000259.html
https://www.php.net/archive/2020.php#2020-08-06-3
https://www.amd.com/en/support/kb/release-notes/rn-amdgpu-unified-linux-20-30
https://blog.mozvr.com/introducing-firefox-reality-pc-preview
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ACTUS

MISE À JOUR D'ELEMENTARY 
OS, LA VERSION 5.1.7
08/08/2020

E lementary OS 5.1.7, positionné com-
me une alternative à Windows et 

MacOS, qui soit rapide, open et res-
pectueuse de la vie privée, est publié. 
L'objectif principal du projet est une 
conception de qualité qui vise la créa-
tion d'un système facile à utiliser avec 
une consommation minimale de res-
sources et une très rapide vitesse de 
démarrage. L'environnement de bureau 
offert aux utilisateurs est leur propre 
Pantheon.

Lors du développement des com-
posants originaux d'Elementary OS, les 
frameworks de GTK3, Vala et Granite 
ont été utilisés. Le kit de distribution 
est basé sur le projet Ubuntu. Ele-
mentary OS 5.1.x est compatible avec 
Ubuntu 18.04 au niveau des paquets 
et dépôts. L'environnement graphique 
est basé sur son propre shell Pantheon, 
qui associe des composants comme le 
gestionnaire de fenêtres Gala (basé 
sur LibMutter), le panneau du haut Wing-
Panel, le lanceur Slingshot, les pan-
neaux de contrôle Switchboard, la 
barre des tâches du bas Plank (le pan-
neau Docky réécrit en Vala) et le ges-
tionnaire de session Pantheon Gree-
ter (basé sur LightDM).

https://blog.elementary.io/updates-
for-july-2020

SERVEUR HTTP APACHE 2.4.46 
PUBLIÉ AVEC DES CORRECTIFS 
DE VULNÉRABILITÉS
08/08/2020

S erveur http, Apache 2.4.46 (ils ont 
sauté les versions 2.4.44 et 2.4.45), 

représente 17 changements et l'élimi-
nation de trois vulnérabilités :

CVE-2020-11984, CVE-2020-11984, 
CVE-2020-9490

https://www.mail-archive.com/
announce@httpd.apache.org/
msg00146.html

AKIRA, UN NOUVEL ÉDITEUR 
GRAPHIQUE VECTORIEL 
POUR LINUX, EST DISPONIBLE
09/08/2020

L a première version test d'Akira, avec 
pour le public cible les concep-

teurs graphiques et les concepteurs 
Web pour la création de la mise en 
page d'interface, est sortie. Le pro-
gramme, qui est écrit en Vala avec la 
bibliothèque GTK, est distribué sous 

licence GPLv3. Des compilations sont 
préparées pour elementary OS et dans 
des formats universels snap et flatpak. 
L'interface est conçue en accord avec 
les directives préparées par le projet 
elementary OS et se concentre sur une 
performance de haut niveau, l'intuiti-
vité et une apparence moderne.

L'objectif ultime du projet est de 
créer un outil professionnel pour les 
concepteurs d'interfaces, un peu simi-
laire à Sketch, Figma ou Adobe XD, mais 
concentré sur l'utilisation de Linux 
comme plateforme principale. Contraire-
ment à Glade et Qt Creator, le nouvel 
éditeur n'est pas conçu pour générer 
du code ou utiliser des trousses d'ou-
tils précises, mais veut résoudre des 
tâches plus générales, comme la créa-
tion de la disposition, de la visuali-
sation et de l'affichage graphique vec-
toriel des interfaces.

https://github.com/akiraux/Akira

PUBLICATION DE L'ÉMULATEUR 
DE LA CONSOLE DE JEU 
RETROARCH 1.9.0
09/08/2020

U ne nouvelle version de RetroArch 
1.9.0 pour l'émulation de diverses 

consoles de jeu, vous permettant d'exé-

cuter des jeux classiques en utilisant 
une interface graphique, simple et uni-
fiée, est disponible au télécharge-
ment. L'émulation de consoles comme 
Atari 2600/7800/Jaguar/Lynx, Game Boy, 
Mega Drive, NES, Nintendo 64/DS, PC-
Engine, PSP, Sega 32X/CD, SuperNES, 
etc., est supportée. Des manettes de 
jeu venant de consoles de jeu exis-
tantes peuvent être utilisées, y com-
pris Playstation 3, Dualshock 3, 8bitdo, 
XBox 1 et XBox360.L'émulateur sup-
porte des fonctionnalités avancées 
comme des jeux multijoueurs, la sau-
vegarde de l'état, l'amélioration des 
images de vieux jeux avec des sha-
ders, le rembobinage des jeux, la con-
nexion à chaud de consoles de jeu et 
le streaming vidéo.

https://www.libretro.com/index.php/
retroarch-1-9-0-released

UNE VULNÉRABILITÉ 
DANS GHOSTSCRIPT 
PEUT ÉVENTUELLEMENT 
PERMETTRE L'EXÉCUTION 
DE CODE À L'OUVERTURE 
D'UN DOCUMENT POSTSCRIPT
10/08/2020

U ne vulnérabilité a été identifiée 
dans Ghostscript, un jeu d'outils 

https://blog.elementary.io/updates-for-july-2020
https://www.mail-archive.com/announce@httpd.apache.org/msg00146.html
https://github.com/akiraux/Akira
https://www.libretro.com/index.php/retroarch-1-9-0-released
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pour le traitement, la conversion et la 
génération de documents PostScript 
et PDF (CVE-2020-15900). Il pourrait 
conduire à la modification de fichiers 
et l'exécution de commandes arbitraires 
lors de l'ouverture de documents Post-
Script spécialement formatés. L'utilisa-
tion de l'opérateur de recherche Post-
Script, qui est non standard, dans un 
document, vous permet de causer un 
débordement de type uint32_t lors du 
calcul de la taille, d'écraser des zones 
de mémoire en dehors du tampon 
alloué et d'accéder à des fichiers dans 
le système de fichiers, qui peuvent être 
utilisés pour organiser une attaque qui 
exécuterait du code arbitraire sur le 
système (par exemple, en ajoutant des 
commandes à ~/.bashrc ou ~/.profile).

Le problème affecte les versions de 
la 9.50 à la 9.52.

https://insomniasec.com/blog/
ghostscript-cve-2020-15900

KDE NEON EST BASÉ 
SUR UBUNTU 20.04
10/08/2020

Les développeurs du projet KDE 
Neon ont publié une version stable 

basée sur Ubuntu 20.04 LTS. Il y a 
plusieurs choix de compilations pour 

KDE Neon : User Edition basée sur les 
dernières versions stables de KDE, De-
veloper Edition Git Stable basée sur 
du code venant de branches bêta et 
stables du dépôt Git de KDE et Deve-
loper Edition Git Unstable basée sur 
les branches de développement de Git.

https://blog.neon.kde.org/index.php/
2020/08/10/kde-neon-rebased-on-20-
04/

PUBLICATION DE GHOSTBSD 
20.08
10/08/2020

L a distribution de bureau GhostBSD 
20.08 est maintenant disponible, 

construite sur la plateforme TrueOS et 
proposant un environnement utilisateur 
MATE. GhostBSD utilise le système init 
OpenRC et le système de fichiers ZFS. 
Les deux fonctionnent en mode Live 
et l'installation sur un disque dur est 
supportée (avec son propre installeur, 
ginstall, écrit en Python). Des images 
boot sont compilées pour x86_64. Dans 
la nouvelle version, le système de base, 
le noyau et des applications, y compris 
la nouvelle publication de l'environne-
ment de bureau MATE 1.24, sont mis à 
jour. Une option est ajoutée au ges-
tionnaire de mises à jour pour sau-
vegarder l'environnement boot avant 

l'installation de la nouvelle version.

http://ghostbsd.org/
20.08.04_release_announcement

FINNIX 121, LA DISTRIBUTION 
LIVE POUR LES ADMINISTRATEURS 
SYSTÈME
10/08/2020

F innix 121 Live est basée sur Debian. 
La distribution est uniquement en 

ligne de commande, mais contient une 
bonne sélection d'utilitaires répondant 
aux besoins d'un administrateur. La 
structure comprend 591 paquets avec 
toutes sortes d'utilitaires. La taille de 
l'image ISO est de 509 Mo.

« Dans la nouvelle version, nous avons 
utilisé la branche tests de Debian à la 
place de versions stables. » De nouveaux 
paquets pour notamment ranger, cpu-
checker, edid-decode, ipmitool, lldpd, 
oathtool, sdparm, sipcalc, socat, xorriso, 
zfs-fuse, sont inclus.

https://blog.finnix.org/2020/08/10/
finnix-121-released/

ÉDITEUR DE TEXTE GNU EMACS 
27.1
11/08/2020

Le GNU Project a publié l'éditeur de 
texte GNU Emacs 27.1. Jusqu'à la 

sortie de GNU Emacs 24.5, le projet 
était développé sous la direction per-
sonnelle de Richard Stallman, qui a 
passé la responsabilité du projet à John 
Wiegley au cours de l'automne 2015.

https://www.mail-archive.com/info-
gnu@gnu.org/msg02771.html

PUBLICATION DE L'ÉMULATEUR 
QEMU 5.1
12/08/2020

E n tant qu'émulateur, QEMU vous 
permet d'exécuter un programme 

fait pour une plateforme matérielle 
sur un système avec une architecture 
totalement différente, par exemple, 
une application pour ARM sur un pC x86-
compatible. En mode virtualisation 
dans QEMU, la performance d'exécu-
tion de code dans un environnement 
isolé est proche du système natif grâce 
à l'exécution directe d'instructions sur 
le processeur et l'utilisation de l'hyper-
viseur Xen ou du module KVM.

https://insomniasec.com/blog/ghostscript-cve-2020-15900
https://blog.neon.kde.org/index.php/2020/08/10/kde-neon-rebased-on-20-04/
http://ghostbsd.org/20.08.04_release_announcement
https://blog.finnix.org/2020/08/10/finnix-121-released/
https://www.mail-archive.com/info-gnu@gnu.org/msg02771.html
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Le projet fut créé à l'origine par 

Fabrice Bellard pour permettre à des 
binaires Linux compilés en x86 de s'exé-
cuter sur des architectures non-x86. 
Au fil des années de développement, 
le support pour une émulation com-
plète a été ajouté pour 14 architec-
tures matérielles, le nombre de dispo-
sitifs matériels émulés dépassant les 
400. Pendant la préparation de la version 
5.1, plus de 2 500 changements ont été 
faits par 235 développeurs.

https://lists.nongnu.org/archive/html/
qemu-devel/2020-08/msg02152.html

422 000 EXEMPLAIRES DE 
LIBREOFFICE 7.0 TÉLÉCHARGÉ 
DANS UNE SEMAINE
12/08/2020

L a Document Foundation a publié 
des statistiques de téléchargement 

pour la semaine suivant la publication 
de LibreOffice 7.0, rapportant que Li-
breOffice 7.0.0 a été téléchargé 422 000 
fois. Le communiqué de presse con-
cernant la nouvelle publication a été 
vu 113 000 fois et la vidéo avec un 
aperçu des innovations, 48 000.

https://blog.documentfoundation.org/
blog/2020/08/12/libreoffice-7-0-a-
week-in-stats/

PUBLICATION DU LANGAGE DE 
PROGRAMMATION GO 1.15
12/08/2020

G o 1.15 est développé par Google 
avec la participation de la com-

munauté comme une solution hybride 
qui associe la haute performance des 
langages compilés à des avantages tels 
que l'écriture de scripts aussi facile 
que celle du code, la rapidité du déve-

loppement et une protection contre 
les erreurs. Le code du projet est dis-
tribué sous licence BSD.

La syntaxe de Go est basée sur des 
éléments connus du langage C avec 
certains venant de Python. Le projet a 
été développé à l'origine en se con-
centrant sur la programmation paral-
lélisée et le fonctionnement efficace 
sur des systèmes à cœurs multiples, 
incluant la fourniture d'outils du niveau 
opérateur pour l'organisation de cal-
culs parallèles et l'interaction entre des 
méthodes exécutées en parallèle. Le 
langage fournit aussi des protections 
intégrées contres des blocs de mémoire 
alloués hors limites et fournit la capa-
cité d'utiliser un ramasse-miette.

https://blog.golang.org/go1.15

LE BULLETIN

HEBDOMADAIRE

DU FULL CIRCLE

Une petite baladodiffusion 
(< 10 mn) avec juste des infor-
mations. Pas de blabla. Pas de 
perte de temps. Seules les der-
nières informations traitant de 
FOSS (logiciels libres Open Sour-
ce) /Linux/Ubuntu.

RSS : http://fullcirclemagazine.
org/feed/podcast

http://distrowatch.com
https://lists.nongnu.org/archive/html/qemu-devel/2020-08/msg02152.html
https://blog.documentfoundation.org/blog/2020/08/12/libreoffice-7-0-a-week-in-stats/
https://blog.golang.org/go1.15
http://fullcirclemagazine.org/feed/podcast
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LA DISTRIBUTION D'INGÉNIERIE 
CAELINUX 2020
13/08/2020

U ne nouvelle publication de CAELi-
nux 2020 est disponible. Elle est 

construite sur la base de Xubuntu 18.04 
et propose une sélection élargie d'appli-
cations spécialisées d'automatisation 
de tâches d'ingénierie, la modélisation 
mathématique et des activités scienti-
fiques. La taille de l'image ISO amor-
çable qui peut fonctionner en mode 
Live est de 5,8 Go (x86_64).

https://www.caelinux.com/CMS3/
index.php/articles/70-/61-caelinux-
202020-released

MALICIEL DROVORUB POUR 
LINUX
13/08/2020

L a National Security Agency (NSA) et 
l'US Federal Bureau of Investiga-

tion (FBI) ont publié un rapport selon 
lequel le 85e centre principal du ser-
vice spécial de la Main Directorate of 
the General Staff of the Armed Forces 
of the Russian Federation (85 GTSSS 
GRU) utilise un ensemble de maliciels 
appelé Drovorub. Drovorub comprend 
un rootkit sous la forme d'un module 

du noyau Linux, un outil de transfert 
de fichiers et de redirection de ports, 
et un serveur de gestion. La partie client 
peut télécharger et téléverser des fi-
chiers, exécuter des commandes arbi-
traires en tant que root et rediriger les 
ports réseau vers d'autres hôtes sur le 
réseau.

https://media.defense.gov/2020/Aug/
13/2002476465/-1/-1/0/
CSA_DROVORUB_RUSSIAN_GRU_MA
LWARE_AUG_2020.PDF

VERSION 20.08 DE KDE APPS
13/08/2020

L a mise à jour cumulative d'applica-
tions d'août (la 20.08) développée 

par le KDE Project est sortie. Au total, 
216 programmes, bibliothèques et ex-
tensions ont été publiés. Des rensei-
gnements sur les nouvelles versions d'ap-
plications se trouvent sur cette page :

https://kde.org/announcements/
releases/2020-08-apps-update/

PUBLICATION D'UBUNTU 
18.04.5 LTS ET 
DE LA 16.04.7 LTS
14/08/2020

L a mise à jour d'Ubuntu 18.04.5 LTS 
est sortie. C'est la dernière mise à 

jour qui comprend des améliorations 
du support du matériel, des mises à 
jour du noyau Linux et de la pile gra-
phique, et des corrections de bugs dans 
l'installeur et le bootloader. À l'avenir, 
les mises à jour pour la branche 18.04 
seront limitées à l'élimination de vul-
nérabilités et problèmes affectant la 
stabilité. Des mises à jour similaires sont 
sorties pour Kubuntu 18.04.5 LTS, Ubun-
tu Budgie 18.04.5 LTS, Ubuntu MATE 
18.04.5 LTS, Lubuntu 18.04.5 LTS, Ubun-
tu Kylin 18.04.5 LTS et Xubuntu 18.04.5 
LTS.

Simultanément, la mise à jour Ubun-
tu 16.04.7 LTS, qui ne comprend que 
les mises à jour cumulatives de pa-
quets liées à l'élimination de vulnéra-
bilités et aux problèmes de la stabilité, 
a été publiée. L'objectif principal de la 
nouvelle publication est de mettre à 
jour les images d'installation. Comme 
dans la publication précédente, les 
noyaux Linux 4.15 et 4.4 sont propo-
sés, ainsi que Mesa, X.Org Server por-
tés d'Ubuntu 18.04 et des pilotes gra-
phiques pour les puces d'Intel, AMD et 

NVIDIA. Le support des mises à jour et 
des correctifs sécuritaires pour les 
éditions server et desktop d'Ubuntu 
16.04 LTS durera jusqu'en avril 2021.

https://lists.ubuntu.com/archives/
ubuntu-announce/2020-August/
000260.html

PUBLICATION DE MCRON 1.2, 
L'IMPLÉMENTATION DE CRON DU 
PROJET GNU
14/08-2020

A près deux ans de développement, 
la publication du projet GNU 

Mcron 1.2 a été annoncée. Dans la nou-
velle version, le code a été très bien 
nettoyé : tout le code en C a été ré-
écrit et le projet comprend mainte-
nant seulement le code source Guile. 
La caractéristique-clé du projet est une 
approche différente de l'organisation, 
de la planification, de l'exécution du 
travail. Au lieu de surveiller sans cesse 
l'heure, Mcron utilise des tâches dans 
une queue linéaire avec la définition 
de délais entre les appels à chaque 
élément de la queue. Pendant les pé-
riodes entre l'activation des tâches, 
mcron est totalement inactif. Cette 
approche réduit de façon significative 
les coûts en ressources de cron et 
augmente la précision du début de 

https://www.caelinux.com/CMS3/index.php/articles/70-/61-caelinux-202020-released
https://media.defense.gov/2020/Aug/13/2002476465/-1/-1/0/CSA_DROVORUB_RUSSIAN_GRU_MALWARE_AUG_2020.PDF
https://kde.org/announcements/releases/2020-08-apps-update/
https://lists.ubuntu.com/archives/ubuntu-announce/2020-August/000260.html
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chaque tâche.

https://lists.gnu.org/archive/html/
info-gnu/2020-08/msg00004.html

PUBLICATION DU DBMS 
SQLITE 3.33
15/08/2020

S QLite 3.33.0, un DBMS léger conçu 
comme une bibliothèque de gref-

fons, est disponible au télécharge-
ment. Le code de SQLite est dans le 
domaine public, c'est-à-dire qu'il peut 
être utilisé sans restriction et gratui-
tement pour tout usage. Les déve-
loppeurs de SQLite sont supportés 
financièrement par un consortium de 
compagnies comme Adobe, Oracle, Mo-
zilla, Bentley et Bloomberg, créées 
expressément à cette fin.

https://www.sqlite.org/changes.html

PARAGON SOFTWARE PUBLIE 
L'IMPLÉMENTATION GPL 
DE NTFS POUR LE NOYAU LINUX
16/08/2020

Konstantin Komarov, créateur et 
PDG de Paragon Software, a sorti 

un jeu de correctifs avec l'implémen-

tation complète du système de fi-
chiers NTFS. Le code est sous licence 
GPL. Le pilote est basé sur le code 
commercial existant des produits de 
Paragon Software et a été bien testé. 
Les correctifs sont conçus pour Linux 
et ne contiennent pas d'autres liaisons 
vers des API additionnelles, ce qui per-
met l'inclusion du nouveau pilote dans 
le noyau principal. Une fois que les cor-
rectifs auront été inclus dans le noyau 
Linux principal, Paragon Software a 
l'intention de fournir la maintenance, 
des correctifs de bug et des amélio-
rations de la fonctionnalité.

https://lore.kernel.org/linux-fsdevel/
2911ac5cd20b46e397be506268718d
74@paragon-software.com/

LE MOTEUR DU NAVIGATEUR 
KOSMONAUT EST ÉCRIT EN RUST
16/08/2020

Le projet Kosmonaut développe un 
moteur de navigateur écrit complè-

tement en Rust et se servant de cer-
tains des développements du projet 
Servo. Le code est distribué sous li-
cence MPL 2.0 (Mozilla Public License). 
Les liaisons OpenGL gl-rs dans Rust sont 
utilisées pour le rendu. La gestion des 
fenêtres et la création de contexte en 
OpenGL sont implémentés avec la bi-

bliothèque Glutin. Les composants 
html5ever et cssparser, développés par 
le projet Servo, sont utilisés pour l'ana-
lyse des HTML et CSS. Le code DOM 
est basé sur le projet Kuchiki. Parmi 
les projets utilisés, le moteur Web ex-
périmental Robinson est également 
mentionné ; il est dans un état semi-
abandonné depuis environ 5 ans.

Au stade actuel du développement, 
le support de base du HTML et un 
ensemble limité de capacités CSS, qui 
ne sont pas encore suffisants pour l'af-
fichage de la plupart des pages mo-
dernes, sont fournis. Cependant, les 
pages simples CSS div sont rendues cor-
rectement.

https://github.com/twilco/kosmonaut

SERVEUR DE COMPILATIONS 
PIRATÉS ET DÉPÔTS LIBRETRO 
COMMUNAUTAIRE COMPROMIS 
DÉVELOPPE RETROARCH
17/08/2020

L a communauté Libretro, qui déve-
loppe l'émulateur de console de jeu 

RetroArch et le kit de distribution pour 
la création de consoles de jeu Lakka a 
averti que l'infrastructure du projet est 
piratée et qu'il y a du vandalisme dans 

leurs dépôts. Les attaquants ont réussi 
à accéder au buildbot et aux dépôts 
sur GitHub.

Le vandalisme a été heureusement 
bloqué par les développeurs avant que 
les attaquants aient atteint le dépôt 
RetroArch clé.

https://www.libretro.com/index.php/
hacker-vandalised-our-buildbot-and-
github-organization/

NOTEPAD++ BLOQUÉ EN CHINE
17/08/2020

Les développeurs de Notepad++ ont 
annoncé que le projet est interdit 

en Chine. Malgré sa prise en charge de 
Windows seulement, l'éditeur Note-
pad++ est très populaire parmi les uti-
lisateurs d'Ubuntu et il est en 5e place 
parmi les plus populaires paquets snap 
pour développeurs (il s'exécute via 
Wine).

On croit que Notepad++ a été in-
terdit à cause de la participation du 
projet dans des actions contre la dis-
crimination contre les Ouïghours et en 
faveur des manifestants à Hong Kong. 
La dernière version, la 7.8.9, était éti-
quetée comme supporteur de la liberté 
et de l'autonomie de Hong Kong et de 

https://lists.gnu.org/archive/html/info-gnu/2020-08/msg00004.html
https://www.sqlite.org/changes.html
https://lore.kernel.org/linux-fsdevel/2911ac5cd20b46e397be506268718d74@paragon-software.com/
https://github.com/twilco/kosmonaut
https://www.libretro.com/index.php/hacker-vandalised-our-buildbot-and-github-organization/
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la 7.8.1 jusqu'à la 7.8.3 comprise, les 
publications étaient livrées avec un 
appel contre le harcèlement des Ouï-
ghours.

https://twitter.com/Notepad_plus/
status/1294991670245818369

PUBLICATION DE KDENLIVE 
20.08
17/08/2020

Kdenlive 20.08 est positionné com-
me un éditeur vidéo semi-pro-

fessionnel. Il peut travailler avec des 
enregistrements vidéo dans les for-
mats DV, HDV et AVCHD et fournit 
toutes les opérations de base de l'édi-
tion vidéo. Par exemple, il vous per-
met de mixer vidéos, sons et images 
au hasard avec la ligne chronologique 
et aussi d'appliquer de nombreux ef-
fets. Le programme se sert de compo-
sants externes comme FFmpeg, le 
framework mLT et le système de con-
ception d'effets Frei0r. Un paquet Ap-
pImage autonome est disponible pour 
installation. 

https://kdenlive.org/en/2020/08/
kdenlive-20-08-is-out/

SORTIE DE OPENRCT2
18/08/2020

Une nouvelle version du projet Open-
RCT2 a été publiée. Il s'agit de 

l'implémentation Open Source du jeu 
de stratégie RollerCoaster Tycoon 2, 
qui simule la construction et la gestion 
d'un parc d'attractions. Le code d'Open-
RCT 2 est disponible sous licence 
GPLv3. La nouvelle publication est im-
portante car elle prend en charge la 
connexion de vos propres greffons en 
JavaScript, fournit la capacité d'impor-
ter des scripts en format « .sea » (RCT 
Classic) et implémente certaines des 
fonctionnalités du premier jeu Roller-
Coaster Tycoon.

Outre les attractions elles-mêmes, 
le jeu OpenRCT2 traite également des 
éléments d'infrastructure, comme des 
boutiques et cafés. La tâche du joueur 
est de réaliser des bénéfices, d'avoir 
et de conserver une bonne image et 
d'attirer des visiteurs. Vous devez 
avoir des fichiers originaux avec des 
données du CD du jeu RollerCoaster 
Tycoon 2. Il supporte des plateformes 
modernes, une interface améliorée, 
une IA améliorée, des outils d'édition 
supplémentaires et la possibilité de 
jeux multijoueurs.

https://github.com/OpenRCT2/
OpenRCT2/releases/tag/v0.3.0

DISTRIBUTION MX LINUX 19.2 
AVEC LE BUREAU KDE
18/08/2020

U ne nouvelle édition de MX Linux, 
la 19.2, livrée avec le bureau KDE 

(Xfce était livré dans l'édition prin-
cipale) est disponible au télécharge-
ment. C'est la première compilation 
officielle avec le bureau KDE depuis 
l'effondrement du projet MEPIS en 
2013. La distribution est basée sur De-
bian avec des améliorations venant du 
projet antiX et de nombreuses appli-
cations propriétaires pour faciliter sa 
configuration et l'installation des logi-
ciels.

https://mxlinux.org/blog/mx-19-2-
kde-now-available/

PUBLICATION DE PARROT 4.10
18/08/2020

B asée sur Debian Testing et compre-
nant un jeu d'outils pour le test 

de la sécurité des systèmes, l'analyse 
médico-légale et l'ingénierie inverse, 
Parrot 4.10 est disponible. Plusieurs ima-
ges ISO sont proposées au télécharge-

ment : avec l'environnement MATE, 
avec le bureau KDE et avec un bureau 
Xfce.

La distribution Parrot est position-
née comme un laboratoire portable avec 
un environnement pour les experts en 
sécurité et les médecins-légistes. Sont 
également inclus : des outils crypto-
graphiques et des logiciels pour un 
accès au réseau sécurisé, y compris TOR 
I2P, anonsurf, gpg, tccf, sulucrypt, vera-
crypt, truecrypt et luks.

https://parrotsec.org/blog/parrot-
4.10-release-notes/

PUBLICATION DE KALI LINUX 
2020.3
19/08/2020

K ali Linux 2020.3 est conçue pour 
les tests de vulnérabilité dans un 

système, l'audit, l'analyse de données 
résiduelles et l'identification des con-
séquences d'attaques malicieuses. Tou-
tes les applications créées au sein de 
la distribution sont distribuées sous 
licence GPL et sont disponibles dans le 
dépôt public Git. Il y a plusieurs va-
riantes d'images ISO disponibles au té-
léchargement.

https://twitter.com/Notepad_plus/status/1294991670245818369
https://kdenlive.org/en/2020/08/kdenlive-20-08-is-out/
https://github.com/OpenRCT2/OpenRCT2/releases/tag/v0.3.0
https://mxlinux.org/blog/mx-19-2-kde-now-available/
https://parrotsec.org/blog/parrot-4.10-release-notes/
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https://www.kali.org/news/kali-2020-
3-release/

PUBLICATION 
DE SOLARIS 11.4 SRU 24
19/08/2020

L a mise à jour du système d'exploi-
tation Solaris 11.4 SRU 24 (mise à 

jour du dépôt de support) est sortie et 
fournit une série de correctifs et d'amé-
liorations régulières à la branche So-
laris 11.4. Pour installer les correctifs 
proposés dans la mise à jour, il suffit 
d'exécuter la commande « pkg update ».

https://blogs.oracle.com/solaris/
announcing-oracle-solaris-114-sru24

LE VER INFORMATIQUE 
FRITZFROG DÉTECTÉ : 
IL INFECTE DES SERVEURS 
VIA SSH ET CONSTRUIT 
UN BOTNET DÉCENTRALISÉ
20/08/2020

L a société Guardicore, un centre de 
données et de sécurité dans le 

nuage, a identifié un nouveau maliciel 
high-tech appelé FritzFrog qui infecte 
les serveurs basés sur Linux. FritzFrog 

associe un ver qui se propage avec 
une attaque de force brute sur des 
serveurs dont un port SSH est ouvert 
et des composants pour construire un 
botnet décentralisé qui fonctionne 
sans nœuds de contrôle et n'a pas un 
seul point d'échec.

D'après les chercheurs, le botnet a 
déjà environ 500 nœuds, y compris les 
serveurs de plusieurs universités et ce-
lui d'une grande entreprise de lignes 
de chemin de fer. La cible principale des 
attaques est les réseaux d'établisse-
ments d'enseignement, les centres mé-
dicaux, les agences gouvernementales, 
les banques et les sociétés de télé-
communications. Après la compromis-
sion du serveur, le processus du mi-
nage de monero, une crypto-monnaie, 
démarre dessus. L'activité de ce mali-
ciel est suivie depuis janvier 2020.

https://www.guardicore.com/2020/08/
fritzfrog-p2p-botnet-infects-ssh-
servers/

MICROSOFT A PORTÉ WSL2 
VERS WINDOWS 10 
1903 ET 1909
21/08/2020

M icrosoft a annoncé la prise en 
charge du Windows Subsystem 

for Linux (WSL2) dans Windows 10 
1903 et 1909, publiées en mai et no-
vembre de l'année dernière. Le sous-
système WSL2, qui fait tourner des fi-
chiers exécutables de Linux sur Win-
dows, a été introduit à l'origine dans la 
publication de Windows 10 2004. Mi-
crosoft a maintenant porté ce sous-
système dans des mises à jour de Win-
dows précédentes, qui restent perti-
nentes et sont utilisées par beaucoup 
d'entreprises. La maintenance des ver-
sions 1903 et 1909 continuera jus-
qu'en décembre 2020 et mai 2022.

https://devblogs.microsoft.com/
commandline/wsl-2-support-is-
coming-to-windows-10-versions-1903-
and-1909/

UNE MISE À JOUR 
DU SERVEUR DNS BIND, 
VERSIONS 9.11.22, 9.16.6, 
9.17.4, CORRIGE CINQ 
VULNÉRABILITÉS
21/08/2020

U ne mise à jour de correctifs de 
bug pour les branches stables de 

BIND, ainsi que dans le développe-
ment de branches expérimentales, est 
sortie. 5 vulnérabilités sont corrigées 
dans les nouvelles versions. La vulné-

rabilité la plus dangereuse (CVE-2020-
8620) permet un déni de service à 
distance par l'envoi d'un ensemble pré-
cis de paquets au port TCP sur lequel 
les connexions BIND sont acceptées. 
L'envoi de requêtes AXFR qui sont anor-
malement grandes au port TCP peut 
engendrer le transfert de la taille vers 
le serveur par la bibliothèque libuv qui 
dessert la connexion TCP, ce qui dé-
clenche la vérification d'assertion et 
arrête le processus (CVE-2020-8621-24).

https://www.mail-archive.com/bind-
announce@lists.isc.org/
msg00579.html

PUBLICATION DU KAIDAN 
XMPP CLIENT 0.6.0
23/08/2020

U ne nouvelle version du Kaidan 
XMPP client, la 0.6.0, est dispo-

nible. Le programme est écrit en C++ 
avec Qt, QXmpp et le framework Ki-
rigami. Le code est distribué sous li-
cence GPLv3. Des binaires sont dispo-
nibles pour Linux (AppImage et flatpak) 
et Android. La publication des binaires 
pour macOS et Windows est retardée.

Une amélioration-clé de la nouvelle 
version est l'implémentation de la queue 
des messages hors ligne ; quand il n'y 

https://www.kali.org/news/kali-2020-3-release/
https://blogs.oracle.com/solaris/announcing-oracle-solaris-114-sru24
https://devblogs.microsoft.com/commandline/wsl-2-support-is-coming-to-windows-10-versions-1903-and-1909/
https://www.mail-archive.com/bind-announce@lists.isc.org/msg00579.html
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a pas de connexion réseau, les mes-
sages sont maintenant mis en cache 
et envoyés automatiquement quand la 
connexion réseau est restaurée.

https://www.kaidan.im/2020/08/20/
kaidan-0.6.0/

ZEXTRAS FAIT MAINTENANT DES 
BINAIRES POUR L'ÉDITION OPEN 
SOURCE DE ZIMBRA 9 
23/08/2020

Zextras a commencé la publication 
de binaires pour le paquet de 

collaboration et de mail Zimbra 9, 
positionné comme une alternative à 
MS Exchange. Les binaires sont pour 
Ubuntu et RHEL respectivement.

Plus tôt, la société Synacor, qui 
gère le développement de Zimbra, a 
annoncé l'arrêt de la publication de 
binaires pour Zimbra Open Source 
Edition et son intention de 
développer Zimbra 9 comme produit 
propriétaire sans partager les 
nouveaux changements avec la 
communauté. Cependant, par la suite, 
Synacor a réexaminé sa décision 
concernant les sources et a continué à 
publier les modifications sur GitHub, 
tout en refusant de générer des 
binaires. En réponse, Zextras, qui est 

impliqué dans le développement de 
Zimbra, a commencé à publier des 
binaires sur son site Web.

https://www.zextras.com/ru/zimbra-
9/

LE BULLETIN

HEBDOMADAIRE

DU FULL CIRCLE

Une petite baladodiffusion 
(< 10 mn) avec juste des infor-
mations. Pas de blabla. Pas de 
perte de temps. Seules les der-
nières informations traitant de 
FOSS (logiciels libres Open Sour-
ce) /Linux/Ubuntu.

RSS : http://fullcirclemagazine.
org/feed/podcast

https://www.kaidan.im/2020/08/20/kaidan-0.6.0/
http://distrowatch.com
https://www.zextras.com/ru/zimbra-9/
http://fullcirclemagazine.org/feed/podcast
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L'APPLI OFFICIELLE FULL CIRCLE POUR UBUNTU TOUCH

B rian Douglass maintient à jour son appli FCM 
pour les dispositifs  UBports Touch qui vous 

permettra de voir les numéros actuels, et les numé-
ros plus anciens, de les télécharger et de les lire sur 
votre smartphone/tablette Ubuntu Touch.

INSTALLATION

Soit vous cherchez « full circle » dans l'Open Store et 
vous cliquez sur Installer, soit vous affichez l'URL ci-
dessous sur votre appareil et vous cliquez sur Installer 
pour être transféré sur la page des téléchargements :
https://uappexplorer.com/app/
fullcircle.bhdouglass

ÉNORME merci à Brian pour ça.

https://uappexplorer.com/app/fullcircle.bhdouglass
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O K, bandes de RUST-iques, nous re-
venons au développement de 

Rust car @Daredevil14 et Ellin se sont 
plaints de la direction que prenait le 
blog de Lucas sur Rust. Il semblerait 
que vous aimeriez toujours plus de rust 
et moins de « non-sens sur la sécurité ». 
En premier lieu, ne négligez pas la 
lecture du livre indiqué le mois dernier. 
Si vous êtes complètement débutant 
dans Rust ou même en programma-
tion, vous trouverez ce qu'il vous faut 
ici, dans le FCM. Ces articles n'ont pas 
l'intention de remplacer le livre cité 
plus haut ; voyez-les plutôt comme 
une aide en parallèle.

Pour le moment, je ne vous donne 
qu'une vision générale des choses. 
Nous pouvons rentrer dans le détail de 
chacun des sujets dont nous avons 
parlé. En général, quand nous voulons 
définir des types personnalisés, ce 
sont des « struct » et des « enum ». 
Nous commençons par les structs.

C'est dans le chapitre cinq du livre 
ci-dessus. Voici le lien direct : https://
doc.rust-lang.org/book/ch05-01-
defining-structs.html

Les structs regroupent des choses, 

comme les statistiques sur vos person-
nages dans un jeu RPG (jeu de rôles). 
Aussi, disons que nous créons un per-
sonnage dans notre jeu de rôle. Les 
personnages ont un nom, ils possèdent 
des attributs « force », « dextérité », 
etc. Ces « caractéristiques » sont les 
mêmes pour tous les joueurs, que ce 
soit un demi-elfe ou un ogre. Si vous 
n'êtes pas familier avec les jeux de 
rôles ou les jeux de Donjons et Dra-
gons (DND ou D&D), regardez rapide-
ment la création d'un tel personnage 
sur le Net. Je n'aime pas cet exemple : 
https://doc.rust-lang.org/rust-by-
example/custom_types/structs.html. 
Mais si vous le comprenez mieux que 
le mien, n'hésitez pas à aller sur cette 
page.

Comme d'autres choses dans Rust, 
nous faisons savoir à Rust ce que nous 
définissons ; donc, nous utilisons le mot-
clé struct.

struct PlayerCharacter
{

name: String,
gender: String,
race: String,
Strength: u8,
Agility: u8,
Constitution: 

u8,
Charisma: u8,

}

Ceux qui s'affichent sont des CSV 
(Comma Separated Values, des don-
nées séparées par des virgules), l'une 
au-dessous de l'autre. Pensez-y comme 
des champs dans un tableur Excel ou 
Calc.

Ainsi, nous définissons la feuille de 
création du personnage, mais comment 
l'utiliser réellement ? Eh bien, pour l'uti-
liser, vous devez vous souvenir d'uti-
liser tous les champs que vous avez 
créés. Pour les besoins d'une dé-
monstration, je ne vais pas saisir tous 
les champs que nous avons listés plus 
haut, mais une sous-section d'entre 

eux. Nous rencontrerons une erreur, 
mais le programme tournera. (Je n'uti-
lise pas tous les champs, c'est tout.)

Vous avez peut-être noté un point-
virgule bizarrement placé après la défi-
nition du joueur. Moi aussi ; pourquoi 
est-il là ? Je dis que c'est parce que 
c'est une déclaration d'affectation, mê-
me si ça n'y ressemble pas d'emblée. 
Cependant, voici plus d'avis : https://
users.rust-lang.org/t/why-is-a-
semicolon-required-at-the-end-of-a-
tuple-struct-definition/25589

Le point important ici est « com-

CCOOMMMMAANNDD  &&  CCOONNQQUUEERR
Écrit par Erik

RRuusstt  PP..  55

https://users.rust-lang.org/t/why-is-a-semicolon-required-at-the-end-of-a-tuple-struct-definition/25589
https://doc.rust-lang.org/book/ch05-01-defining-structs.html
https://doc.rust-lang.org/rust-by-example/custom_types/structs.html
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ment ». Comment utiliser un struct. 
Nous pouvons passer le code en re-
vue.

Nous définissons notre variable 
« player » (joueur) comme affectée au 
nom de struct « PlayerCharacter ».

Pour mémoire, les variables ne sont 
pas des variables dans Rust, à moins 
d'utiliser le mot-clé mut. Aussi, si vous 
prévoyez de modifier ces variables - 
disons la force ou l'agilité pendant 
que votre personnage monte les ni-
veaux -, vous avez besoin de mut 
derrière let.

Ensuite, nous remplissons tous les 
champs définis, que nous prévoyions 
de les utiliser immédiatement ou non. 
(Vous noterez que je ne les utilise pas 
et que j'ai eu des erreurs de com-
pilation. Si vous poursuivez, vous pou-
vez les ignorer pour le moment et 
vous verrez la sortie désirée.) Nous 
terminons notre déclaration d'affec-
tation avec un point-virgule. Pensez à 
lui comme à une instance de struct.

Alors, qu'est-ce qui se passe dans 
le println ? Quand vous faites réfé-
rence au champ que vous voulez, vous 
avez besoin de « nomdevariable.nom-
duchamp ». La raison pour cela vient 
de ce que vous pouvez peut-être avoir 
plusieurs « PlayerCharacters » et vous 

ferez référence à chacun d'eux comme 
player1.name ou player2.name (à la 
place de mon pauvre character.name). 
Voyez-vous où ça nous mène ?

Je dois insister sur le fait que les 
structs avec des champs nommés ne 
sont pas le seul type. Le premier est 
un struct de tuple. Dans un struct de 
tuple, les champs sont invariables ; ils 
n'ont donc pas besoin d'être nommés.

Bon, d'accord, je viens de regarder 
ceci ce matin : https://www.youtu-
be.com/watch?v=wh4aWZRtTwU. 

Aussi, ne condamnez pas mon exem-
ple. C'est vraiment DUR de trouver 
des exemples simples ! (En haut à droite.)

Nous faisons simplement référence 
à la position des contenus du tuple.

Un struct de tuple, ce n'est pas pa-
reil qu'un tuple !

Je n'arrive pas pas à trouver un cas 

d'utilisation dans la vraie vie, mais la 
programmation n'est pas mon travail 
quotidien ; aussi, si quelqu'un veut 
participer, qu'il se sente libre !!!

Un struct unit est un autre type. 
C'est un struct sans aucun champ. Je 
ne sais pas dire quel est son usage, 
mais nous en parlerons dans le prochain 
numéro quand nous regarderons les 
enums.

Si j'ai fait une erreur, corrigez-la en 
m'envoyant un mail à : 

misc@fullcirclemagazine.org

Erik travaille dans l'informatique depuis 
plus de 30 ans. Il a vu la technologie aller 
et venir. De la réparation de disques durs 
de la taille d'une machine à laver avec 
multimètres et oscilloscopes, en passant 
par la pose de câbles, jusqu'au dimen-
sionnement de tours 3G, il l'a fait. 

Struct Colour(u32, u32, u32);

fn main()
{
   let Colour1 = Colour(150,75,0);

   println!(“Dark orange is {}, {}, {} in RGB.”, Colour.0, Colour.1, Colour.2);
   println!(“Brown is {}, {}, {} in RGB.”, Colour.0, Colour.1, Colour.2);
}

https://www.youtube.com/watch?v=wh4aWZRtTwU
mailto:misc@fullcirclemagazine.org
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TTUUTTOORRIIEELL
Écrit par Greg Walters PPyytthhoonn  ddaannss  llee  mmoonnddee  rrééeell  --  PP..110088

B onjour, j'espère vraiment que tout 
le monde est en bonne santé. Ici 

dans le centre du Texas, il a fait très 
chaud. Une température de l'air de 
104° F (40° C) avec un index de chaleur 
bien au-dessus de 107 (41,6 °C) pen-
dant des jours, et on s'attend à ce que 
ça dure au moins pendant les 7 pro-
chains jours.

Le mois dernier, j'ai commencé à 
vous montrer la bibliothèque pyFPDF. 
Ce mois-ci (le FCM n° 160), nous con-
tinuerons à regarder cette bibliothè-
que et examinerons sa partie « Tem-
plate ».

Ma supposition était que la fonc-
tionnalité Template avait été conçue 
au départ pour gérer des choses com-
me des factures et des étiquettes. De 

plus, je pensais qu'elle pourrait être 
facilement utilisable pour produire 
des choses comme des impressions de 
recettes ou n'importe quoi d'autre 
dont vous voudriez que les données 
soient prépositionnées dans une posi-
tion x/y sur une page et restituées 
dans un fichier PDF. J'avais partielle-
ment raison, mais il semble que pyF-
PDF ne soit pas complètement au point 
pour ma tâche, comme je la conçois, 
sans une tonne de travail.

Je commencerai avec un échantil-
lon de recette sorti de la base de 
données d'un livre de cuisine, qui 
représente une recette sur une seule 
page « normale » lors d'une éventuelle 
impression. Dans son « état » actuel, le 
programme du livre culinaire crée une 
page html à la volée, basée sur la re-

cette qui doit être imprimée, puis l'en-
voie au navigateur par défaut pour l'im-
pression. Elle ressemble à quelque chose 
comme l'image ci-dessous à gauche.

Pas la plus jolie, je dois l'admettre, 
mais elle fait son travail et gère les 
situations où un utilisateur a besoin 
d'une copie papier de la recette (comme 
si c'était un ami qui ne pourrait pas 
vivre sans la recette), tout comme les 
recettes qui comportent un grand 
nombre d'ingrédients et/ou beaucoup 
d'instructions, et qui se déroulent sur 
deux ou trois pages.

Revenons à la bibliothèque pyFPDF ; 
à première vue, la documentation est 
plutôt maigre pour certaines des op-
tions. Elle était généralement compré-
hensible et semblait être assez facile à 
traduire pour ce que je souhaitais faire. 
Eh bien, je me trompais vraiment. Elle 
EST maigre et certaines informations 
prêtent à confusion. Je vous en parle-
rai au fur et à mesure de notre pro-
gression.

Puisque je fournis presque toujours 
le code et la plupart des choses dont 
vous avez besoin pour faire tourner 
les démos que je crée pour ces ar-

ticles, je ne voulais pas tenter de vous 
fournir toute la base de données. Il y a 
plus de 300 recettes et images (dans 
un dossier séparé), et je ne pense 
vraiment pas que pastebin me laissera 
téléverser une base de données sql et 
autant d'images (ou aucune image). 
Aussi, j'ai créé un simple programme 
pour extraire 3 recettes « normales » 
sur une seule page et je les ai codées 
en dur dans une série d'« enregistre-

ments » qui sont ensuite transformés 
en listes pour chaque table. Ensuite, 
avec une impression des recettes dans 
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TUTORIEL - PYTHON
mon presse-papier et une règle à la 
main, j'ai commencé à disséquer les 
coordonnées XY auxquelles je voulais 
mettre chacun des éléments.

J'ai décidé d'utiliser la méthode du 
codage en dur pour la définition des 
éléments plutôt que la méthode CSV, 
car je n'étais pas sûr de comment les 
choses fonctionneraient et s'assem-
bleraient. Si ça marchait, je pourrais 
toujours créer directement un CSV 
par la suite. Je suis vraiment heureux 
de ne pas l'avoir fait. Vous compren-
drez plus tard.

Du fait de l'utilisation des f-strings, 
j'aurai besoin d'utiliser Python 3.7.4 
ou plus.

J'ai commencé avec les fichiers d'en-
tête et de titre de recette. Ça s'est fait 
plutôt bien et j'ai été capable de dé-

finir ces deux éléments. Avec un des 
programmes échantillons, j'ai com-
mencé à faire des copier/coller entre 
leur programme et mon code.

À droite, voici un exemple raccour-
ci de la structure de l'élément :

Comme vous pouvez le voir, c'est 
une liste de dictionnaires. Nous en dé-
taillerons une :
••Name est le nom par lequel vous vou-
lez y faire référence.
••Type est le type de l'élément qu'il dé-
finit. Les options documentées sont : 
'T': textes, 'L': lignes, 'I': images, 'B': 
boîtes, 'BC': barcodes (plus là-dessus 
dans un moment).
••X1, Y1, X2, Y2 sont les positions xy 
dans une boîte imaginaire. D'en haut à 
gauche au bas à droite.
••Ensuite viennent les spécifications 
des polices, les définitions de l'arrière-

plan et et du premier plan, l'aligne-
ment, le texte (s'il y en a) et la priorité 
de l'élément sur l'axe Z. Le texte peut 
être écrasé quand l'élément est appelé.
••Il y a aussi un attribut optionnel pour 
lignes multiples qui, s'il est utilisé, sera 
à la fin du dictionnaire.

Actuellement dans la documenta-

tion, la spécification de Type ne mon-
tre que ces 5 options. Cependant, en 
creusant le code de la bibliothèque, il 
y en a une autre. C'est « W » pour 
Write (écrire). Elle a été ajoutée pour 
permettre les liens (URL) dans les mo-
dèles (en utilisant la méthode write), 
mais peut être utilisée dans d'autres 
occasions. La bonne nouvelle pour cette 

# Template...
elements = [
    {
        'name': 'header', 'type': 'T',
        'x1': 17.0, 'y1': 8.0,
        'x2': 0, 'y2': 0,
        'font': 'Arial', 'size': 8,
        'bold': 0, 'italic': 0,
        'underline': 0, 'foreground': 0,
        'background': 0, 'align': 'L',
        'text': '', 'priority': 2,
    },
    {
        'name': 'title', 'type': 'T',
        'x1': 17, 'y1': 26,
        'x2': 0, 'y2': 0,
        'font': 'Arial', 'size': 22,
        'bold': 1, 'italic': 1,
        'underline': 0, 'foreground': 0,
        'background': 0, 'align': 'L',
        'text': '', 'priority': 2,
    },
    {
        'name': 'recipeimage', 'type': 'I',
        'x1': 17, 'y1': 25,
        'x2': 80, 'y2': 89,
        'font': None, 'size': 0,
        'bold': 0, 'italic': 0,
        'underline': 0, 'foreground': 0,
        'background': 0, 'align': 'L',
        'text': 'image', 'priority': 2,
    },
    …
}
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option, c'est qu'elle marche de la mê-
me manière que la fonction appelée 
chapter_body que nous avons créée le 
mois dernier. Elle permet qu'un texte 
du type d'un paragraphe de plusieurs 
lignes soit restitué correctement d'une 
manière « fluide ».

De ce que j'ai pu voir avec mes 
essais limités, il n'y a pas de différence 
dans la priorité (l'ordre sur Z) quelle 
que soit la valeur utilisée. Je n'ai pas 
passé trop de temps sur cette partie 
de mon test.

J'étais quelque peu inquiet à pro-
pos du type d'image, car les images 
que j'utilise ne sont pas de taille stan-
dard. Comme la plupart ont été récu-
pérées sur le Web, certaines sont en 
mode paysage et certaines en por-
trait. Certaines sont plutôt grandes et 
d'autres assez petites. Par chance, le 
rendu des images redimensionne l'ima-
ge pour qu'elle s'adapte aux limites 
fixées pour le positionnement XY.

Maintenant, jetons un regard à la 
section Ingredients du PDF. Je voulais 
vraiment que l'en-tête et le texte de la 
liste soient alignés à gauche, comme 
dans l'image imprimée en haut de l'ar-
ticle. Pour la liste des ingrédients (et 
les instructions), j'ai finalement dû uti-
liser la méthode d'écriture « W ». La 
méthode de texte normal « T », avec 

le multiligne réglé à True (Vrai)(il uti-
lise la méthode multi_cell en interne) 
ne fonctionnait pas correctement. Le 
seul inconvénient est visuel, parce qu'une 
indentation de la première ligne du « 
paragraphe » est mise d'office. Alors 
que c'est joli pour le paragraphe d'un 
chapitre, ça ne va pas (au moins pour 
moi) et c'est un peu perturbant.

Vous voyez en haut à droite la défi-
nition des éléments pour ingredient-
shead (Titre des ingrédients) et ingre-
dientitems (composition) qui est très 
voisine de la section des instructions :

Notez que la position y1 pour le 
texte fixe « Ingredients » est à 220, 
alors que le bloc des composants est 
placé à 115. Pour moi, ça n'a pas de 
sens. La même chose se produit avec 
le texte fixe des instructions et le 
texte flottant de celles-ci.

Maintenant que nos données sont 
définies et que le dictionnaire des élé-
ments est paramétré (voir le code en 
entier pour la définition complète des 
éléments), tout ce qui reste à faire est 
de réaliser la fonction qui passera à 

travers l'ensemble du document de 
recette et restituera le document (ci-
dessous).

Ainsi, la définition de la fonction 
accepte un paramètre appelé « which ». 
Ce sera l'index de la recette dans la 
« base de données ». Nous plaçons le 
titre de la recette et l'id de la recette 
dans des variables séparées, non seu-
lement pour les utiliser maintenant, 
mais aussi plus tard. Ensuite, nous ins-
tancions l'objet template, en définis-
sant le titre du document, le format 
de l'épreuve imprimée et les éléments. 

Vous pouvez aussi paramétrer ici les 
propriétés du document (auteur, sujet, 
etc). Enfin, nous ajoutons une page 
avec la méthode add_page(). À nou-
veau, c'est assez proche de ce que 
nous avons fait le mois dernier.

Ainsi, pour paramétrer les différents 
éléments du document, nous appe-
lons les éléments que nous voulons 
inclure avec, dans certains cas, une 
chaîne - une à la fois. Le format est :

Object[element] = chaîne de 
caractères optionnelle

   {
        'name': 'ingreidentshead', 'type': 'T',
        'x1': 17, ‘'y1': 220, 'x2': 0, 'y2': 0,
        'font': 'Arial', 'size': 12, 'bold': 1,
        'italic': 1, 'underline': 0,
        'foreground': 0, 'background': 0,
        'align': 'L', 'text': 'Ingredients:',
        'priority': 2,
    },
    {
        'name': 'ingredientitems', 'type': 'W',
        'x1': 17, 'y1': 115, 'x2': 90, 'y2': 400,
        'font': 'Arial', 'size': 11, 'bold': 0,
        'italic': 0, 'underline': 0,
        'foreground': 0, 'background': 0,
        'align': 'L', 'text': '',
        'priority': 2, 'multiline': True
    },

 
def create_pdf(which):
    recipetitle = recipe_table_dat[which][1]
    recipeid = recipe_table_dat[which][0]
    f = Template(format="Letter", elements=elements, title="Recipe Printout")
    f.add_page()
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Le code de cela est ci-contre, en 

haut à droite.

Comme il n'y a pas de manière di-
recte de gérer une liste, je suis passé 
pas à pas dans la liste des ingrédients 
et j'ai créé une chaîne qui est ensuite 
paramétrée en utilisant l'élément ingre-
dientitems (en bas à gauche).

La section des instructions est gé-
rée de la même manière.

Enfin (en bas à droite), nous res-
tituons la page à peu près comme 
nous le fîmes le mois dernier, mais, 
cette fois, nous utilisons le titre de la 
recette comme nom de fichier du PDF. 
Après ça, nous indiquons à l'utilisateur 
que le traitement est fini.

Pour terminer, j'avais besoin de trou-
ver un moyen pour que le programme 
invite l'utilisateur à sélectionner la re-
cette à utiliser. J'ai créé un menu simple 
en ligne de commande (à droite, 
avant-dernier tableau).

Et une routine qui boucle et pré-
sente le menu jusqu'à ce que l'utilisa-
teur utilise « 0 » pour quitter (au mi-
lieu à droite).

Bon, c'est tout. Je crois que, en 
tant que générateur rapide de PDF 
qui peut être facilement contrôlé en 
Python, pyFPDF est un bon outil. Ce-
pendant, comme moteur de modèle 
(en anglais, template), je ne suis pas 
convaincu qu'il fonctionnera dans le 
monde réel. Étant donné le fait que 
les dernières modifications du code 
ont été faites il y a 3 ans, je ne garde 
pas beaucoup d'espoir que l'auteur ré-
solve les nombreux problèmes autour 
du moteur de modèle. Il y a une grosse 
partie de moi qui voudrait travailler 

    f["header"] = f"Greg's cookbook - {recipetitle} - Recipe ID {recipeid}"
    f["title"] = recipetitle  # 'Mongolian Beef and Spring Onions'
    f["recipeimage"] = images_table_dat[which][2]
    f["description"] = recipe_table_dat[which][8]
    f["source"] = recipe_table_dat[which][2]
    f['servings'] = f'Servings: {recipe_table_dat[which][3]}'
    f['time'] = f'Total Time: {recipe_table_dat[which][4]}'
    f['rating'] = f'Rating: {recipe_table_dat[which][5]}'

itms = len(ingredients_table_dat[which])
ings = ''
for itm in range(itms):
    ings = ings + ingredients_table_dat[which][itm][5] + 
"\n"

f["ingredientshead"]
f["ingredientitems"] = ings
f["instructionhead"]
f["instructions"] = instructions_table_dat[which][2]

    filename = f'./{recipetitle}.pdf'
    f.render(filename)
    print(f'\n\n{"=" * 45}')
    print('        PDF has been generated')
    print('     Please open the PDF manually')
    print('=' * 45)
    print('\n\n')

def menu():
    print('Please select a recipe...')
    print('1 - Mongolian Beef and Spring Onions')
    print('2 - Amish White Bread')
    print('3 - "Crack" Chicken')
    resp = input('Please enter 1, 2, 3 or 0 to quit --> ')
    if resp == "0":
        print('Exiting program!')
        sys.exit(0)
    elif resp in ("1", "2", "3"):
        return resp
    else:
        return -1

def mainroutine():
    loop = True
    while loop:
        resp = menu()
        if resp == -1:
            print('Invalid selection.  Please try again')
        else:
            print(f'Requested recipe: {resp} \n')
            create_pdf(int(resp) - 1)
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sur un fork (branche dérivée) du pro-
jet et modifier moi-même le code, mais 
la vie et le temps et le travail (comme 
toujours) m'empêchent de le faire 
tout de suite. Ce n'est qu'un élément 
de plus dans la liste de choses à faire.

Normalement, j'aurais posté le code 
du projet, s'il était plus avancé que le 
seul fonctionnement direct avec le 
shell de Python. Ce mois-ci, je vais 
rompre avec la tradition et ne pas le 
poster sur pastebin.com. La raison en 
est que je ne crois pas que pastebin 
me permette de poster les fichiers 
des images des recettes. C'est aussi 
une des raisons pour lesquelles je n'ai 
pas travaillé directement sur la base 
de données des recettes, qui, actuel-
lement, contient plus de 300 recettes, 
avec une image pour chaque recette. 
Aussi, j'ai créé un dépôt sur GitHub 
pour y placer le projet de ce mois. En 
agissant de cette manière, tout ce que 
vous avez à faire est de suivre le lien 
vers le dépôt, télécharger le projet en 
fichier zip (vous pouvez le cloner, mais, 
dans mon esprit, c'est beaucoup d'ef-
forts perdus de votre part), dézipper 
le dossier à un endroit qui vous con-
vient et lancer le programme en py-
thon, appelé template1.py. Le lien vers 
le dépôt est : https://github.com/greg-
wa1953/FCM160. Un autre avantage 
est que si quelque chose arrive et que 
je perds un domaine (comme c'est 

arrivé dans le passé), le dépôt y res-
tera pour toujours ou jusqu'à ce que 
github meurt. Étant donné la quantité 
de code sur github, je doute VRAI-
MENT que ça arrive.

Quelques nouvelles de plus avant 
que je ne vous quitte pour ce mois. Le 
mercredi 5 août, j'ai signé un contrat 
pour écrire un autre livre. Celui-ci sera 
sur l'apprentissage de l'utilisation de 
PAGE pour créer des interfaces utilisa-
teur graphiques pour Python. J'ai écrit 
quelques articles sur PAGE dans le 
passé, et je suis sûr que je le ferai aussi 
dans le futur. Le titre provisoire, pour 
le moment, est Learning Page A GUI 
Designer for Python (Apprendre PAGE : 
un concepteur de GUI pour Python) et 
j'estime qu'il sera publié aux environs 
de janvier 2021.

Aussi, comme toujours, jusqu'à la 
prochaine fois : soyez prudent, en bonne 
santé, positif et créatif !

Greg Walters est un programmeur à la 
retraite qui vit dans le centre du Texas, 
aux États-Unis. Il est programmeur de-
puis 1972 et à ses heures perdues, il est 
auteur, photographe amateur, luthier, 
musicien honnête et très bon cuisinier. Il 
est toujours propriétaire de RainyDaySo-
lutions, une société de conseil, et passe 
la plupart de son temps à rédiger des 
articles pour la FCM et des tutoriels. Son 
site est www.thedesignatedgeek.xyz .

http://www.thedesignatedgeek.xyz
https://github.com/gregwa1953/FCM160
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I n the first article in this series, I 
talked about the hardware you will 

need to start to record your podcast 
and for later post production of your 
Audio. In this article, we will look at 
some of the software for recording 
and editing your audio content.

If you use a standalone audio 
recording device, such as the Zoom 
H2 recorder I mentioned in the first 
article, you will be ready to go, as far 
as recording goes; as all the software 
needed to do this is embedded into 
the device. The device will have 
options as to the file format you wish 
to record in, such as .wav or .Mp3, and 
some recorders may be able to record 
in .ogg or .flac formats.

Depending on your needs and the 
amount of post production you are 
planning, then .wav or .Flac will give 
the best high-quality lossless audio 
where the audio file retains as much 
of the audio detail as was picked up 
during recording without loss of 
quality. The .wav format is the 
standard CD audio format, and will 
take up the most file space, typically 
around 8.7MB per minute of audio, 
whereas for a .Flac file, at full quality, 

is typically around 5MB per minute. If 
you have limited storage space on 
your recording device, you may wish 
to record in .Mp3, which, at standard 
quality of 128kbits per second, will 
generate a file of about 1MB per 
minute of audio recorded (or 
transcoded from one of the other 
formats). But, apart from the 
decisions you need to consider 
regarding file formats when recording 
your audio, with a 
standalone device like 
the Zoom H2 you are 
good to go. Put a set 
of batteries in the 
device and read the 
Manual so you know 
the way it operates 
and start to record.

If you plan to 
record your audio 
on a mobile phone, then obviously you 
will need a recording application for 
this. As I don’t use an iPhone, I can’t 
comment on their software for this 
job, but there is a list of 
recommended apps here. And I’m 
sure it will have a voice recording app 
by default and this may be good 
enough.

Android has numerous 
applications in the Play store for audio 
recording. A couple that get fairly 
good reviews are:
• ‘Easy Voice Recorder’ which has both 
a free (with Ads) and paid version, and 
can record to several different audio 
file formats.
• The other is simply called ‘Voice 
Recorder’ and again comes as a ‘Free’ 

with ads version and 
an ad-free paid 
version.
• A full list of some of 
the other options are 
here.

Remember that, 
as with many 
Android apps, you 
will want to check 
out what the app 

wants access to on the phone when 
you consider if you want to install it to 
your device. I’m not sure how much of 
an issue this is with Apple devices.

You may just want to experiment 
with the default option on your device 
and stick with that if you feel it is 
adequate, but there are a number of 

applications that can record audio on 
your mobile device, be it an Android 
or iOS device.

If you will be recording on a 
Desktop or laptop PC, then your 
options in Linux are very good indeed. 
A quick search of the web comes up 
with many lists but the most common 
used by most in the Linux community, 
and I include myself in that, is 
Audacity – which is top of the list. 
Ronnie did a great Basics of Audacity 
tutorial in FCM#109, which is a great 
place to start with this powerful audio 
editing tool. Another good choice is 
Ardour although I have not personally 
used it. I know several people who 
have more professional audio editing 
experience than myself, and who feel 
this is a more complete solution if you 
have more professional recording 
editing and mixing needs, but it is not 
going to be as user-friendly to 
someone starting to get to grips with 
the basics of audio editing as 
Audacity. My recommendation would 
be to start with Audacity as there are 
lots of tutorials on the web to get you 
started, and the basics are fairly easy 
to master.
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We started this by looking at 

software for recording, but you will 
also need software to edit your audio 
if you are going to do anything to it 
before you post it to the internet in 
your chosen way.

If you are using an Android device, 
and I would not recommend a phone 
for this, but with a 10”+ tablet it is 
probably possible. There are a 
number of applications that can edit 
your audio once recorded, although as 
I have not tried this method and this is 
about using Linux to start your 
podcasting journey, all I’ll say is that 
this is a link to 8 such programs 
(https://techwiser.com/audio-editing-
apps-for-android/).

As for using Linux for editing, the 
list above (which I suggested as 
solutions for recording audio) also 
work for editing. Again my suggestion 
for the beginner would be to start 
with Audacity, and, as you get more 
confident and your needs become 
more complex, you may wish to check 
out Ardour or one of the other more 
task-specific programs that may have 
the more complex functionality you 
may need.

If you are recording a solo podcast 
then the above is all the software you 
may need, but if, like myself, you have 

decided to jump into the world of 
recording with more than one person, 
and you are not all able to be in the 
same room, town, or even continent, 
at the same time, then you will need 
some software that will enable you to 
talk to each other and record at the 
same time. 

There are a number of solutions 
for this in Linux, but the two that 
spring to mind, and that I have used, 
are Skype and Mumble.
• Skype, while not being 
open source, if there 
are only a few of you, 
might be your simple 
option as you do not 
have to have a 
server set up to do 
this – the 
infrastructure is 
provided by 
Microsoft. 
• Mumble however, 
while it is open source 
software, will require the setting up 
of a Mumble server which can be 
hosted either in the cloud or on a local 
server, and if you do not have the 
ability to do this by yourself or have 
access to someone else's server, it 
might not initially be a solution you 
can use. Although if you are recording 
content for a podcast that already has 
a server set up, such as Hacker Public 

Radio, and you ask nicely, then they 
may allow you to use theirs when it’s 
not in use.

There is also the ability to record 
the conversation on Skype and 
Mumble, but it is also advisable for 
each of the participants to record 
their audio locally as well. This is for 
two reasons: first you will have a 
better quality of final edit using the 
local recordings and mixing them 
together in post production than the 

server audio, but you can 
then use the Skype/
Mumble recording as 
your backup solution 
if, for any reason, 
things go wrong 
with any of the local 
recordings. I‘m not 

sure about Skype, but 
Mumble allows the 

recording of separate 
tracks for those on the 

call, so you can use the audio 
track for whoever's local audio went 
wrong, and not the whole of the 
recording from the call stream, if 
needed. 

So in these last two articles, we 
have looked at the hardware and 
software you will need to get started 
in the podcast world. In the next 
episode, I will look at your options for 

getting your audio out to the listening 
public, and how to go about this.

https://techwiser.com/audio-editing-apps-for-android/


full circle magazine n° 160 25 sommaire ^

TTUUTTOORRIIEELL
Écrit par Erik

RRaawwtthheerraappeeee  --  PP..  66

L a Côte des squelettes est un mer-
veilleux endroit pour prendre des 

photos de... si vous êtes là au bon mo-
ment et au bon endroit. Si vous n'avez 
pas la chance de vivre au voisinage et 
finir par avoir une opportunité de photo 
au mauvais moment de la journée, nous 
pouvons vous aider. Nous ne sommes 
pas tous soutenus financièrement par 
la BBC pour attendre là-bas le jour par-
fait. La Côte des squelettes dispose de 
magnifiques contrastes, qui rendent la 
destination attirante pour les photo-
graphes. Ne vous êtes-vous jamais émer-
veillé devant ces photographies éton-
nantes que vous voyez dans les ma-
gazines de voyage ? Eh bien, laissons 

notre photographie « kitsch » devenir 
une « photo de magazine ».  

Comme le tronc dans le lac de Nou-
velle-Zélande, les troncs morts de Sos-
susvlei dooievlei sont photographiés 
jusqu'à plus soif. Vous ne me croyez 
pas ? Cherchez les images dans votre 
navigateur favori.

Notre défi est de donner à notre 
image la même qualité que ces photo-
graphies professionnelles. Cependant,  
notre image est plutôt « plate ». c'est 
dû au brillant soleil d'été, lorsqu'on 
prie pour avoir un nuage... et, bien sûr, 
pour l'avoir prise au mauvais moment 

de la journée, mais nous ne nous aven-
turerons pas sur ce terrain-là. C'est le 
moment pour qu'un super logiciel Open 
Source vienne à la rescousse. Pour 
votre gouverne, il n'y a aucune rede-
vance mensuelle/annuelle de licence !

Maintenant, si nous regardons les 
exemples que j'ai dans ma recherche, 
vous verrez que le ciel semble artifi-
ciel. Nous n'en voulons pas. Ça res-
semble évidemment à quelque chose 
comme une modification automatique 
ou une mauvaise modification manuelle. 
Idem pour les images où le ciel et la 
dune se mélangent pour donner une 
couleur plus claire...

Toutes les couleurs de notre image 
sont fades, ce qui laisse penser que 
vous devez commencer par là. Il y a 
une raison pour que l'exposition soit 
le premier onglet. Il est supposé être 
votre premier arrêt. Notre histogramme 
nous donne un indice, en se penchant 
sur la droite. Nous avons aussi un peu 
d'espace vide sur la gauche, signifiant 
que nous pouvons jouer aussi sur les 
ombres. Juste en nous limitant à des 
modifications basiques, rien de très 
poussé, nous pouvons immédiate-
ment améliorer le rendu de cet ins-
tantané. Nous descendons notre expo-
sition dans les négatifs et jouons avec 
les contrastes et la saturation. Jusqu'à 
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ce que notre image soit réaliste. No-
tre histogramme devrait être bien sé-
paré en rouge/vert/bleu (en ignorant 
les bords) et installé au centre, tandis 
que les tons plus sombres se dis-
tinguent eux-mêmes comme les points 
centraux de l'histogramme.

Je vous la fais court : ne réflé-
chissez pas trop. Vous ne continuez pas 
à chercher vos clés de voiture quand 
vous les avez trouvées.

On peut voir que les réalisateurs de 

ce génial éditeur Open Source ont pen-
sé à comment une photo pouvait être 
modifiée, avant de travailler sur l'inter-
face. Vous n'avez pas besoin d'être un 
expert si les choses sont logiques et 
linéaires, tout comme vous n'avez pas 
besoin d'être un chef pour cuire du 
pain si vous avez une recette et une 
méthode. Ensuite, vos expériences 
vous amèneront jusqu'au bout du che-
min. 

Vous voulez peut-être ajouter quel-
ques points plus lumineux, mais es-

sayez de coller à : moins, c'est mieux. 
Aussi, passons à Détail. La simple acti-
vation de Netteté l'a fait pour moi, 
bien que j'y reviendrai quand j'active-
rai et vérifierai mon contraste. À nou-
veau, la simple activation du Con-
traste local le fait. Il faut l'admettre, il 
ne se passe pas grand chose sur cette 
image ; aussi, quand l'arbre mort com-
mençait à ressortir, je me suis arrêté. 
Un peu poète, je sais...

Passons à Couleur. Nous avons beau-
coup de bruit de couleur. La raison 

vient du moment où cette image a été 
prise. L'espace mémoire valait de l'or 
et une carte SD de 2 Go valait autant 
qu'une carte 64 Go aujourd'hui ; aussi, 
pas question d'utiliser le raw. L'algo-
rithme jpeg de l'époque n'était pas 
aussi efficace que maintenant, pas plus 
que les processeurs d'image. Nous 
avons déjà parlé de la manière de gé-
rer le bruit de couleur ; je ne me ré-
pète donc pas.

Comme il n'y a pas grand chose 
que je puisse y faire pour les couleurs, 
je passe directement à la vibrance. 
Augmentez les tons pastels, mais n'en 
faites pas trop. Au lieu de saisir et 
ballader la réglette, utilisez le bouton +. 
Lentement, faites ressortir la vie dans 
la photographie. Le ciel bleu peut ten-
dre vers l'artificiel, mais nous regar-
derons sa correction dans un autre tu-
toriel.  

Vous pouvez maintenant passer à 
Transformation et choisir votre profil 
de correction d'objectif. Comme c'était 
un appareil photo ancien, mon objec-
tif était listé, mais si le vôtre ne l'est 
pas, vous pouvez importer votre fi-
chier LCP. Toutes les instructions sont 
ici : https://rawpedia.rawtherapee.com/
How_to_get_LCP_and_DCP_profiles

Ainsi, nous avons maintenant une 
couleur vive, nous avons réglé la net-

https://rawpedia.rawtherapee.com/How_to_get_LCP_and_DCP_profiles
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teté de l'image et nos points de lu-
mière et d'ombre ressortent. Cepen-
dant, si nous regardons le sable, nous 
notons que ce n'est pas Arrakis et qu'il 
y a des détails dans les dunes. Nous 
voulons attirer l'attention vers eux, les 
faisant mieux ressortir et rendant notre 
image plus « réelle ». Retournez sur l'ex-
position (vous avez maintenant fait un 
tour complet du cercle - un « Full Cir-
cle »   ) et activez la carte des tona-
lités. Vous voyez (peut-être) quelque 
chose se passer. Nous allons seulement 
ajuster la fonctionalité de limitation des 

bords. Déplacez la réglette vers le haut 
jusqu'à ce que les détails dans la dune 
commencent à apparaître. Agrandis-
sez tant que vous pouvez ; vous voulez 
voir les creux, les pierres et les herbes. 
Vous devez faire un compromis entre 
le proche et le lointain. Souvenez-vous 
de vérifier le terrain près de vous et le 
terrain le plus éloigné, et trouvez un 
équilibre dans les détails. Si vous n'y 
avez jamais été, pour vous donner une 
idée, c'est un groupe de gens sur la 
dune en arrière-plan. 

Nous pouvons maintenant enre-
gistrer notre profil de modification en 
haut à droite et l'appliquer à la pro-
chaine image de la même région, nous 
permettant d'accélérer notre traite-
ment.

Conseil : Travaillez par petits pas si 
vous voulez que vos images restent 
naturelles ; faites des pas de géant si 
vous voulez choquer avec de merveil-
leuses œuvres d'art. 

Notre image finale se distingue fiè-

rement au milieu des autres images 
affichées sur Internet et nous n'avons 
pas dû attendre longtemps pour l'op-
portunité « parfaite ».

J'espère que vous avez pris plaisir 
si vous m'avez suivi et que vous avez 
appris quelque chose. 

Avertissement : En aucune manière, 
je ne suis expert en manipulation des 
photos. Je connais juste un gars qui a 
un chien qui m'a passé des puces. Je 
pensais que je pourrais aussi vous ai-
der à vous gratter.

Comme toujours, si vous avez des 
questions ou des commentaires, adres-
sez-les à : misc@fullcirclemagazine.org

Erik travaille dans l'informatique depuis 
plus de 30 ans. Il a vu la technologie aller 
et venir. De la réparation de disques durs 
de la taille d'une machine à laver avec 
multimètres et oscilloscopes, en passant 
par la pose de câbles, jusqu'au dimen-
sionnement de tours 3G, il l'a fait. 

mailto:misc@fullcirclemagazine.org
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Échec et mat, 
mise à jour 

de Windows 10 ! 
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A mazingly, this is the centenary 
article in this series! That’s not 

bad given that my original plan was 
for maybe half a dozen short pieces as 
a brief introduction to Inkscape. I 
doubt there are many people who 
have read all of the articles, but even 
if you just dropped into one or two as 
reference material for a specific 
feature, I hope you’ve found them 
useful.

This month, I’ll be continuing to 
look at Inkscape v1.0. Although there 
are a lot of exciting new things to 
cover – and I promise to get to them in 
the coming months – for now I’m 
going to return my focus to some of 
the problems that have found their 
way into the new release. It’s not that 
I want to be a pessimist, I’d just prefer 
to get the issues out of the way as 
quickly as I can.

The regressions that most users 
are likely to stumble across are largely 
related to path operations on text 
objects. Manipulating text to produce 
a graphical effect is a common task 
for Inkscape users, when creating a 
logo or just trying to make the text on 
an image look more interesting. 

There’s little you can do with a pure 
text object, apart from the usual 
rotate, scale and skew. Filters can 
produce some amazing results – 
whilst still keeping the text editable – 
but are difficult to work with, and are 
best used to provide texture or 
shadows rather than for 
fundamentally changing the letter 
shapes. At some point in your 
graphical adventures, you’re bound to 
find yourself converting text to a path 
in order to manipulate it further.

CONVERTING TEXT TO A PATH

Logos and styled text form the 
basis of a huge number of Inkscape 
tutorials, almost all of which require 
the user to convert their text to a path 
at some point, via the Path > Object to 
Path menu option. Depending on the 
age of the tutorial, and the version of 
Inkscape it targets, this can lead to 
very different outcomes.

For most elements in Inkscape the 
result of Object to Path has always 
remained the same. A rectangle 
becomes a path. An ellipse becomes a 
path. Spirals and polygons become 
paths. It may sound obvious, but in 

most cases the Object to Path feature 
turns your object into a path. With 
older versions of Inkscape (prior to 
0.48) the same was true of text 
objects: the entire text would be 
converted into a single complex path. 
Most tutorials deal with applying an 
effect or style to the entire text, so 
creating a single path is just what is 
wanted. But sometimes you need to 
be able to work with the individual 
letters. Splitting the complex path 
into separate letters is a fiddly task 
that requires some experience to do 
easily. So, with 0.48, the developers 
changed the Object to Path behaviour 
when applied to text elements: to this 
day it creates a group of paths, one 
for each letter.

This change in behaviour 
immediately made a lot of tutorials 
slightly obsolete, and led to a 
persistent trickle of new users to 
Inkscape support sites posting 
requests along the lines of “I’m 
following this tutorial on YouTube and 
I get as far as converting my text to a 
path, then the next step doesn’t 
work…”. In case you were in any 
doubt about the longevity of content 
on the internet, the trickle of users 

following tutorials written for 0.46 
and earlier continues to this day.

The ‘obvious’ solution to this 
change is to ungroup the converted 
text, then join the paths together 
using Path > Union or Path > Combine. 
But whether by accident or design, 
the developers did leave a shortcut in 
place that allowed for a one-step 
conversion of text to a single complex 
path. Rather than use Object to Path, 
selecting the text object and going 
straight to Path > Union would have 
the desired effect. This quickly 
became the common response to 
new users following older tutorials, 
and also became a prominent method 
in newer tutorials. It’s worth noting 
that Path > Combine, when applied to 
a text object, also created a single 
path but it still puts it inside a group, 
which is arguably a little useless. 
Nevertheless, for 0.48 and 0.92 there 
are four ways to convert text to one 
or more paths.

Unfortunately, Inkscape 1.0 
removes the Path > Union shortcut. To 
make matters worse, the status bar 
shows an “error” stating that “one of 
the objects is not a path, cannot 
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perform boolean operation”, even 
though it does convert the text to 
paths, albeit in the same way as the 
Object to Path option.

So now there’s a resurgent flow of 
new users to support sites who are 
finding that tutorials for 0.48 or 0.92 
are also incorrect with the new 
version. But as there’s no longer a 
one-step solution to this task, the 
answer is usually to use the three-step 
approach.

INSET AND OUTSET

Related problems appear when 
using Path > Inset and Path > Outset. 
In both these cases, Inkscape 0.92 and 
earlier handled text objects as a 
special case: the text would 
automatically be converted to a single 
path for you before the effect was 

applied. But with 1.0, the results are 
not only not what you might expect, 
but the UI is downright misleading!

With your text object selected, 
choosing one of these options might 
be expected to make it thinner (Inset) 
or thicker (Outset). Earlier versions did 
this, via the implicit conversion to a 
path, so although there were some 
users who were surprised that their 
text was no longer editable as a text 
object, for most the experience was in 
line with expectations. Try the same 
with 1.0, however, and the status bar 
says “No paths to inset/outset in the 
selection”. What it doesn’t 
immediately make clear, however, is 
that rather than failing benignly, 
leaving your text object untouched, it 
has also converted your text to a 

group of paths! So not only does it fail 
to do what you originally wanted, but 
it’s changed the nature of your object 
in the process.

Initially it might seem that the 
quick solution is to apply the inset or 
outset effect twice: the first converts 
the text to a group of paths, and the 
second then applies the desired 
effect to those paths. But alas, the 
first operation leaves the group itself 
selected, not the paths, and applying 
inset/outset to a group doesn’t work, 
even if that group consists of nothing 
but paths. Instead, the best solution is 
to perform the three-step conversion 

above to convert the text to a single 
path, and only then apply the inset/
outset operation.

DYNAMIC OFFSET

The Path > Dynamic offset 
operation seems to be particularly 
misleading when applied to text in 
version 1.0. In older releases, the 
behaviour was similar to inset/outset: 
there would be an implicit conversion 
to a single path before the real 
operation was applied. In this case, 
the operation results in a small 
diamond-shaped handle that can be 
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dragged to dynamically adjust the 
inset or outset amount.

Not so in 1.0. Initially, there’s no 
visible change, except that the 
selection box has lost its handles, and 
the pointer looks different. That’s 
actually because Inkscape has 
switched you to the Node tool. The 
usually helpful status bar is now 
positively misleading. “Drag to select 
objects to edit”, it begins. So you try 
dragging across the whole text: no 
change. You drag over a few of the 
letters: now the selection box 
disappears completely.

“… click to edit this object”, it 
continues. So you click on a letter, and 
are presented with the node handles 
for the path making up that one 
letter. Because, yet again, when you 
first clicked the Dynamic Offset menu 
entry, your text object was converted 
into a group of paths, one per letter. 
You can click on other letters, and in 
each case the previous one is de-
selected, and the clicked one shows 
its nodes. Shift-clicking selects 
multiple letters. You can drag the 
nodes, add them, delete them, and 
generally work with the Node tool as 
usual. But there’s no handle 
presented for dynamically adjusting 
the inset/outset which was, after all, 
what you were trying to do in the first 

place.

As with inset/outset, the dynamic 
offset effect doesn’t work when 
applied to a group of paths. Unlike 
those operations, however, it also 
won’t work when applied to a 
selection of several paths – instead 
dropping you into the Node tool, even 
on earlier Inkscape releases. This 
means that there are no shortcuts: 
you simply can’t avoid converting your 
text to a single path if you want to use 
the dynamic offset feature on it. It’s 
back to performing the three-step 
conversion process first.

LINKED OFFSET

The last command in this group, 
Path > Linked Offset, also fails to work 
with text in 1.0, but this time the 
workaround is quite different – it’s 
more complex, but does at least 
provide some useful functionality in 
the process. Let’s have a quick 
refresher on linked offsets in 0.92, and 
why I think they’re usually a better 
option than inset/outset or dynamic 
offsets when working with text.

If you look at the SVG output for 
each of these commands, you’ll start 
to understand the differences 
between them. Inset and outset 

simply create a new path element 
that replaces your original object 
entirely. There’s no trace of it left in 
the file. They’re useful when you just 
want to make another path element a 
bit fatter or thinner, and don’t need to 
retain the original path in any way. 
Viewed in this way, you can 
understand why text (or any other 
shape) has to be converted to a path 
for these operations to work.

Dynamic offset is a little different. 
Yet again a path is created, completely 
replacing the original object. Like all 
SVG paths, it contains a “d” attribute 
which holds the details of the path 
shape, so that other programs can 
display it correctly. But this path has 
some additional Inkscape-specific 
attributes that are not usually present 
on a path. The first is “sodipodi:type” 
with a value of “inkscape:offset”, 
indicating to Inkscape that this path 
should be treated differently to 
normal paths.

The second special attribute is 
“inkscape:original” which holds a copy 
of the original path that was used to 
create this offset path. Although the 
original path has been removed from 
the drawing, it lives on in this 
attribute, the content of which can 
even be copy-pasted into another 
path object to reconstruct the original 

shape. The third attribute, 
“inkscape:radius”, holds the size of the 
offset – i.e. how far you have moved 
the handle from its original position.

When a path has these attributes 
set, Inkscape no longer uses the “d” 
attribute to draw the path. Instead it 
calculates the new shape based on 
the original path and the radius 
(offset) value. Change either of these 
and you’ll see that Inkscape updates 
the “d” attribute automatically, but 
this is just so that the shape appears 
correctly in other software.

A linked offset also creates a path, 
but leaves the original object 
untouched. This path is similar to the 
dynamic offset case, but adds one 
more special attribute into the mix, in 
the form of “inkscape:href”. This holds 
a reference to the original, untouched 
object.

The new path still contains a “d” 
attribute, for other software to use. 
But it also still contains an 
“inkscape:original” attribute, again 
holding a path shape. This time, 
however, the path data here is 
created by implicitly converting the 
source object (the one pointed to by 
inkscape:href) into a path. If you 
change the source object, Inkscape 
updates the “inkscape:original” value 
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which, in turn, results in an update to 
the “d” value.

What does that mean in practice? 
It means that your original object 
retains its original type. Stars are still 
stars, and can be edited with the 
appropriate tool. Spirals and 
rectangles, again, are left untouched 
and can still be edited with their own 
tools. And yes, text is also left as text, 
meaning that you can change the 
font, style and even the content, with 
the linked offset updating 
automatically. This alone makes it the 
best option for offsetting text. You 
can hide the original or place it off the 
page if you want, but when you later 
discover a typo, or need to edit the 
words, you can make those changes 
to the original text and know that 
your offset version will stay in sync.

But not in Inkscape version 1.0.

Yet again in this version trying to 
use the command just converts the 
text to a group of paths and switches 
you to the node tool. You can use the 
three-step conversion to create a path 
before you select the menu entry – 
but that completely defeats the point 
of using a linked offset rather than a 
dynamic offset.

Luckily the underlying rendering 

engine isn’t broken. If you present it 
with a linked offset created in an older 
version of Inkscape it displays 
correctly, and the original object still 
retains its original type and editability. 
Fortunately, we can reproduce this 
behaviour entirely in 1.0, but it does 
involve some use of the XML editor. 
These are the steps you’ll need to 
follow:
• Select your text object and open the 
Object Properties dialog via the 
context menu, or the Ctrl-Shift-O 
shortcut.
• Copy the ID from the dialog to the 
clipboard. Close the dialog.
• Create a temporary object. Just 
about any sort will do, but I usually use 
a rectangle or ellipse. Making it a 
distinct color will help to keep track of 
things later.
• Apply the Path > Linked Offset 
function to the temporary object.
• With the linked offset selected, open 
the Edit > XML Editor dialog.
• The linked offset should already be 
selected in the editor. You should see 
the extra attributes I described 
previously.
• Change the inkscape:href attribute: 
delete most of the content, but leave 
the “#” in place, then paste the ID 
from the clipboard immediately after 
it.
• Press Enter to make the change. You 
should see your text apparently 

change to the color of the temporary 
object. What you’re actually seeing is 
the linked offset positioned on top of 
your original text.
• The Inkscape UI is a little confused at 
this point, as the temporary object will 
still be showing the linked offset 
handle. Switch to the Selection tool to 
get things back under control.
• Delete the temporary object.
• Double-click on the linked offset 
text, or select it and switch to the 
Node tool and you should see the 
usual offset handle. Adjust this to 
change your offset amount.

It seems like a lot of steps, but all 
we really did was create a linked 
offset to another object, then 
adjusted the link to point to our text 
object instead. Most importantly, our 
text remains untouched, so can still be 
edited using the normal text tools, 
with the linked offset updating 
automatically.

One final thing to note is that the 
steps above also work for other 
shapes. If you want your rectangles to 
remain as rectangles, or your stars to 
still be editable with the star tool, 
you’ll need to follow those steps to 
avoid Inkscape 1.0 automatically 
converting your source objects into 
paths.

REVERSING SUB-PATHS

I mentioned this issue back in part 
95, when Inkscape 1.0 was still in Beta. 
Unfortunately the final release still 
suffers from the same problem.

With older versions, if you have a 
complex path (i.e. one with sub-paths), 
you could select a single node in the 
sub-path, then use Path > Reverse to 
reverse just that sub-path. This can be 
invaluable when working with the 
nonzero fill-rule, as described in part 
95. In Inkscape v1.0 the Path > 
Reverse option reverses every sub-
path, regardless of what was selected.

There is only one way to work 
around this issue, and it’s something 
of a pain on more complex designs. 
You have to use Path > Break Apart, 
then reverse the sub-path in question, 
then select all the constituent paths 
before using Path > Combine to put 
them back together into a single 
complex path.

FINAL THOUGHTS

I hadn’t really planned to celebrate 
100 articles with a text-heavy trawl 
through bugs and a deep dive into 
offsets, but these are the sort of 
problems that will affect lots of users, 
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so warranted spending some time on. 
It just goes to show that new isn’t 
always better, and makes a strong 
case for sticking with 0.92 for the time 
being, especially if you’re a new user 
following some online tutorials.

All these problems have been 
reported, and I have added extra 
comments or information on the bug 
reports where necessary. Hopefully 
the next release will address some of 
these issues – many of which look as 
though they have a common 

underlying cause.

Next month I’ll move back onto 
some of the good stuff in Inkscape 
1.0, hopefully without bumping into 
any more serious bugs along the way.

Mark a utilisé Inkscape pour créer trois 
bandes dessinées, The Greys, Monsters, 
Inked et Elvie, qui peuvent toutes être 
trouvées à http://www.peppertop.com/

http://www.peppertop.com
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Écrit par Alan Ward

KKrriittaa  ppoouurr  rreettrraavvaaiilllleerr  ddee  vviieeiilllleess  pphhoottooss  --  PP..1100

T his series is aimed at learning to 
make something of the old 

photos in my possession and others in 
the public domain, due to their age. 
You, the reader, are welcome to tag 
along and, I hope, glean some small 
insight and perhaps an idea or two 
from time to time. No promises are 
made as to the quality of the content, 
or potential errors and omissions. I am 
a computer scientist, not a true artist 
or a professional in image restoration. 
So please take all this as a best effort, 
but with no firm guarantees — much 
as is the case of most open-source 
software.

In the previous part of this series, 
we took a look at an interior photo 
which exhibited the typical lack of 
sensitivity of early digital cameras’ 
sensor chips. In this part, we will work 
on the opposite defect: washed-out 
colors due to too much light in the 
original scene for the camera to 
handle. This is typical in outdoor shots 
where plenty of sunlight has 
illuminated the scene. Contrary to 
popular belief, the problem may 
actually become worse in slightly 
overcast or hazy conditions, where a 
lot of reverberation tended to 

overload early light sensors. This was 
the case in the following scene from 
the island of Cheung Chau in Hong 
Kong.

There is clearly enough light here 
to take a clear picture, since even the 
shadows under the tree branches 
hold enough detail. However, the 
sensor was unable to handle the 
sunlight bouncing off the white 
buildings in the background, the 
illuminated part of the tree trunk, or 
bicycles’ chrome handlebars. But, is 
this excessive light the case for all 
primary colors? The Histogram 
window (at menu Settings > Dockers > 
Histogram) gives us a more complete 
story:

Going from left to right, in the first 
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place we see that very dark pixels at 
the far left of the histogram are few, 
though among these there is a 
tendency to contain a blue tinge and a 
defect of cyan. There is, in fact, a large 
proportion of pixels that have 
intensities in the middle range, with 
some reddish tinge to them. There is 
also a distinct lack of light-colored 
pixels in the middle of the top quarter 
to the right of the histogram, and 
these have a magenta tinge to them. 
Finally, there is a very heavy group of 
very light (whitish) pixels to the 
extreme right of the graphic.

Thus, from a standpoint of light 
exposure, what we have seen in the 
histogram shows us that the image is 
in fact globally rather well-balanced, 
except for the very light pixels. This 
tells us more about how the (old) 
digital camera’s chip reacted to light in 
the first place. Its response was 
correct for low and medium levels of 
incident light, but exaggerated for 
higher levels, which leads us to 
deduce a lack of calibration of the 
software that translated electrical 
signals into colors levels in the 
controlling software.

On the other hand, there seems to 
be some relationship between color 
balance, and pixel intensity value. Let 
us examine this further. The Layers 
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Docker that is usually found in the 
lower right-hand corner of Krita’s 
window has a second tab, Channels. 
Using this tab, we can activate or 
deactivate at will any or all of the main 
Red, Green, Blue and Alpha 
(transparency) channels in our image, 
without actually making any changes 
to pixel values. 

After some tests, it becomes clear 
that all channels have, in fact, lost a lot 
of detail in the lighter pixels. Of the 
three main colors, Red is the channel 
that holds more information of the 
darker colors -- and, thus, it is the 
channel that represents better the 

details in the shady part of the tree. In 
other words, the chip inside the 
camera seems to have been more 
sensitive to red light than blue or 
green, especially at higher intensities.

At this point, we can take our 
handling of the image in several 
different directions. The first would 
be to try to balance intensities on a 
channel-by-channel basis. In Filter, 
Adjust and Color-adjustment curves, I 
started by giving the general 
luminosity response a slight tweak in 
the middle of the higher quarter of 
the scale. What I am doing is 
counteracting the corresponding peak 

at the rightmost end of the 
histogram, and trying to eek out some 
more detail from the washed-out 
whites. This is clearly not working.

A very slight increase in the details 
of buildings at the back of the image 
is achieved, but at the expense of 
rather weird-looking colors, for 
instance in the greenish pane 
windows to the left. Could I get better 
results by working on a single 
channel? As before, I went into the 
Color adjustment curves window, and 
now tried adjusting each channel 
individually. The end result is the very 
same: details are not forthcoming. It is 

in fact clear that a large quantity of 
information has simply been lost 
inside the lighter parts of the image. 
Whichever way we go about it, once 
lost, this information cannot be 
retrieved since it is no longer within 
the image.

 
So, what can be done? An 

alternative approach is to step back 
and think about what we have been 
doing. The main center of our interest 
in this image is clearly the tree itself, 
and the heap of bicycles parked 
around it. The buildings in the 
background are less noteworthy, and 
give very little to the complete 
message. So, what if we exaggerated 
the process, and blanked out the 
burned whitish buildings altogether? 
We could thus concentrate on the 
photo’s main subject, with fewer 
distractions.

We can do this either in color, or in 
black-and-white. When we examined 
the image’s color channels previously, 
the red channel actually had quite a 
nice vibe to it. So I went back into the 
channels part of the Layer docker, and 
turned off both the blue and green 
channels. I then went back into Layers, 
and added a new transparency layer. 
Then, using the airbrush at low 
opacity (about 30 to 50%) and some 
pure white, I scrubbed out selectively 
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parts of the buildings in the 
background, concentrating on their 
darker elements that stood out more 
such as window frames. Other 
vegetation such as some palm trees in 
the background were also cleared up. 
The end result allows the main subject 
to stand out from its surroundings, 
and the eye can concentrate on the 
details that struck the photographer’s 
imagination when taking the photo 
more than a decade back.

In this part of the series, we 
examined the effects of excessive 
light on one of the first digital 
cameras, seeing how very light colors 
got easily washed out. Since much 
information on details has not been 
retained within the image file, it is 
now impossible or very difficult to put 
it back into the image through color 
curve manipulation. Thus, it may be 
advantageous to proceed otherwise, 
thinking more about the global effect 
that is required and trying to use the 
burned-off parts of the original photo 
to our advantage. In the next part of 
the series, we will work on another 
early digital photo, in which the 
camera’s optics and light-sensitive 
chip lost some definition in an 
otherwise quite pleasing scene, due 
to their lack of resolution at the time. 
Until then, take care!
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par ErikTheUnready

Taper avec un doigt… 

La lutte est réelle !
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LLAA  BBOOUUCCLLEE  LLIINNUUXX
Écrit par S. J. Webb

SSPPII

I l y a de nombreuses sociétés à but 
non lucratif qui s'occupent des logi-

ciels gratuits et Open Source. On en 
connaît quelques-unes par cœur, comme 
la Free Software Foundation. Pendant 
que je parlais de la OpenZFS Founda-
tion, j’ai découvert une autre fonda-
tion nommée Software in the Public 
Interest. C’est assez intéressant de sa-
voir que le projet Debian a créé Soft-
ware in the Public Interest après que 
la Free Software Foundation a terminé 
son support. Cette entité à but non 
lucratif a démarré à New York aux 
États-Unis d’Amérique en 1997. Leur 
mission est de gérer les aspects non 
techniques et légaux de projets im-
portants.

Actuellement, 40 projets sont par-
rainés par Software in the Public In-
terest. Certains de ces projets vont 
des jeux aux distrib. basées sur Arch. 
Pour qu’un projet soit parrainé, il doit 
être approuvé par le Conseil de la 
fondation. Les projets peuvent traiter 
du matériel ou des logiciels, du moment 
qu’ils sont Open Source. 

Les champs de travail les plus im-
portants sont la tenue ou la distri-
bution de fonds, la tenue de fonds im-

portants, la tenue d’actifs incorporels, 
la signature de contrats, l’aide légale 
et les services techniques.

Si une demande précise d’aide au-
delà de leur service standard est pré-
sentée, le conseil peut l’étudier pour 
voir à quel point elle est raisonnable.

Il y a deux niveaux d’appartenance 
à Software in the Public Interest : la 
participation et la non-participation. Les 
membres qui ne contribuent pas sont 
ceux qui vivent dans l’esprit de l’utili-
sation de logiciels gratuits et open. Les 
membres qui participent sont actifs dans 

la création de logiciels gratuits et open. 
En d’autres termes, les utilisateurs de 
Linux typiquement sont qualifiés de 
membres non-participants.

Il est intéressant de voir l’objectif 
dédié d’aider des développeurs de lo-
giciels pour le côté non-codage des 
projets de logiciels Open Source. Je 
ne peux que me demander combien 
de projets seraient encore existants s’ils 
avaient utilisé ces services.

Au mois prochain... je n’ai toujours 
pas trouvé un sujet pour le mois pro-
chain.

SJ Webb est passionné de Linux et co-
ordonnateur de recherche. Il aime pêcher, 
conduire des bolides et passer du temps 
avec ses enfants et sa femme. Il remer-
cie Mike Ferrari pour son mentorat. 
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UUBBUUNNTTUU  AAUU  QQUUOOTTIIDDIIEENN
Écrit par Richard Adams

RReennddrree  GGNNOOMMEE  uuttiillee

J e vois que l’une des choses encen-
sées à propos du Bureau GNOME, 

c’est sa « propreté ». Personnellement, 
je le trouve toujours « clairsemé »  de-
puis la première fois que je l’ai vu il y a 
des années. Ceci peut être controversé, 
mais je n’ai jamais adhéré à l’idée d’un 
bureau « propre », surtout quand l’en-
vironnement des activités force l’utili-
sateur final à l’adopter. Le bureau peut 
et doit être une partie très utile de 
votre environnement informatique, pas 
seulement joli ou pur.

Beaucoup d’utilisateurs de Linux 
viennent d’un milieu où ils utilisaient 
la ligne de commande pour accomplir 
une grande partie de leurs tâches quo-
tidiennes ; il est vrai que la ligne de 
commande est facile d’accès et que 
beaucoup de tâches peuvent être faci-
lement faites à partir de la CLI, ou 
Interface en ligne de commande. Les 
lecteurs de longue date (vous deux) 
sauront déjà que j’utilise souvent les 
commandes « apt » en ligne de com-
mande pour installer et mettre à jour 
des logiciels et que, en général, je les 
préfère aux alternatives GUI (en inter-
face graphique). (En passant, j’aime bien 
la nouvelle appli Ubuntu Software, car 
vous avez l’impression d’acheter des 

logiciels en ligne dans une boutique 
qui est très bien conçue.) Je pense, 
parfois, que, si vous êtes davantage à 
l’aise avec la ligne de commande, vous 
pouvez ne pas réaliser à quel point l’uti-
lisation d’une GUI moderne peut rendre 
votre vie informatique plus efficace.

Ici, ma thèse est que le bureau 
peut être un endroit très utile pour 
mettre des raccourcis vers des pro-
grammes, et des raccourcis vers des 

fichiers et les emplacements de fi-
chiers. Cela peut se faire d’une ma-
nière organisée et systématique qui 
favorise l’efficacité tout en gardant le 
bureau plus ou moins « propre ». Ce-
pendant, dès l’installation, GNOME y 
fait obstacle en vous INTERDISANT de 
mettre des raccourcis sur le bureau, ce 
que je trouve absolument inexplicable 
et extrêmement frustrant. Si on ré-
fléchit au problème même de façon 
très superficielle, on arrive à la conclu-

sion que cela devrait être une ques-
tion de CHOIX, pas une règle, de ce 
que vous pouvez ou ne pouvez pas 
raisonnablement mettre sur votre bu-
reau. Après tout, il s’agit de VOTRE 
bureau et il devrait fonctionner comme 
VOUS le voulez.

En résumé, je ne veux surtout pas 
devoir constamment trier les applica-
tions que j’utilise à partir du tiroir « Show 
Applications » (c’est l’ensemble des 
carrés blancs en bas 
du lanceur des Favo-
ris) :

De plus, il n’y a pas assez de place 
sur le lanceur de Favoris GNOME pour 
les applications que j’utilise le plus sou-
vent (comme décrites dans Ubuntu au 
quotidien, FCM n° 158, page 41). Je 
veux mettre des choses sur mon bu-
reau afin d’y accéder plus efficacement 
et je considère cela plus important que 
l’attrait esthétique d’un bureau « pro-
pre ». Mais comment peut-on remé-
dier à cette lacune de GNOME ?

Voici, à gauche, le bureau GNOME 
standard que vous verrez dès l’ins-
tallation :
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UBUNTU AU QUOTIDIEN
Comme vous pouvez le constater, 

il y a deux icônes sur le bureau : l’une 
pour votre Dossier personnel (Home) 
et l’autre pour la Corbeille, mais rien 
de plus. Vous ne pouvez pas faire un 
glisser-déposer d’icônes d’application 
à partir de Show Applications vers le 
bureau, comme vous pouvez le faire à 
partir du Dash d’Unity.

INSTALLER GNOME TWEAKS

Nous allons devoir installer un logi-
ciel supplémentaire pour arriver à nos 
fins. Si vous n’avez pas déjà mis une 
icône du terminal dans les Favoris (à 
nouveau, Full Circle n° 158, page 41), 
nous allons devoir appeler le Terminal 
d'une façon « difficile ». En haut de 
l’écran, cliquez sur Activités.

Dans la zone qui dit « Taper pour 
chercher » tapez term. Cela devrait être 

assez pour que l’icône du Terminal s’af-
fiche. Cliquez dessus pour lancer le 
Terminal.

Le logiciel supplémentaire dont 
nous avons besoin s’appelle GNOME 
Tweaks. Pour l’installer, nous utilise-
rons la commande apt-get dans le 
Terminal. À l’invite du Terminal saisis-
sez  :

sudo apt-get install gnome-
tweaks

puis appuyez sur Entrée. Vous devez 
être connecté à l'Internet pour pou-
voir télécharger et installer le logiciel. 
Répondre à toutes les invites, y com-
pris la demande du mot de passe d’ad-
ministrateur que vous avez créé quand 
vous avez configuré Ubuntu. La partie 
« sudo » de la commande est l’abrévia-
tion de Super User DO et dit au sys-
tème d’exploitation que la commande 

qui suit sera exécutée au nom d’un 
administrateur, ou Super User, d’où la 
demande de votre mot de passe. L’ins-
tallation et la mise à jour de logiciels 
sous Ubuntu ne peuvent se faire que 
par un administrateur, ou super user.

Après très peu de temps, apt-get 
terminera l’installation de GNOME 
Tweaks et affichera un message à cet 
effet dans le Terminal. Nous pouvons 
maintenant ajouter des icônes au bu-
reau en appelant Tweaks et en acti-
vant les icônes du bureau.

Cliquez sur Activités en haut de 
l’écran.

Dans la zone qui dit « Tapez pour 
rechercher », tapez twea. Cela devrait 
être suffisant pour afficher l’icône de 
GNOME Tweaks. Faites un clic gauche 
dessus pour lancer Tweaks (ci-dessous 
à gauche).

Cliquez sur Extensions à gauche 
pour arriver à la zone des icônes du 
bureau (en bas à droite).

Vous pouvez maintenant cliquer 
sur le curseur à droite pour activer les 
Icônes du bureau. Vous pouvez aussi 
cliquer sur l’icône d’engrenage à côté 
du curseur pour voir les options des 
icônes de bureau.
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Voici, ce qui est, malheureusement, 

la partie très contre-intuitive et tou-
jours difficile du processus. Nous devons 
trouver les fichiers « .desktop » pour 
toute application que nous voulons 
ajouter au bureau et il y a des empla-
cements possibles multiples pour ces 
fichiers.

D’abord, lancez votre navigateur de 
fichiers : l’icône sur le lanceur des Fa-
voris qui ressemble à un dossier de 
fichiers.

Une fois dans le Gestionnaire de 
fichiers, cliquez sur le menu « ham-
burger » en haut à droite (celui qui 
ressemble à trois lignes horizontales 
droites). Cela affichera les options du 
Gestionnaire de fichiers.

Si ce n’est pas déjà activé, cochez la 
case « Afficher les fichiers cachés » et 
vous verrez de nombreux fichiers et 

dossiers commençant par un « . » - 
c’est comme ça que Linux dit au sys-

tème d’exploitation qu’un fichier ou 
un dossier devrait normalement être 
caché.

L’emplacement de vos fichiers « .desk-
top »  sera différent selon la configu-
ration de votre système pour un ou 
plusieurs utilisateurs, selon la version 
précise d’Ubuntu que vous utilisez et 
peut-être aussi par application. Sur une 
installation d’Ubuntu 20.04 à un seul 
utilisateur, la plupart de ces fichiers se 
trouveront dans /usr/share/applications. 

Je vous entends demander, « Qu’est-
ce que cela veut dire et comment y 
aller ? ». Eh bien, nous allons devoir 
accéder à quelques-uns des fichiers 
système de Linux qui sont en dehors 
de notre Dossier personnel, où la 
plupart de nos activités sous Linux ont 
lieu. Ne vous inquiétez pas, ce n’est 
pas TROP effrayant.

TROUVER LES FICHIERS .DESKTOP

D’abord, il faut trouver le chemin 
vers le dossier root du système. Ce 
n’est pas intuitif sous Ubuntu, mais 
c’est fait exprès sans doute, car la 
plupart des utilisateurs n’ont jamais 
besoin d’y aller. Est-ce que vous voyez 
« (Autres emplacements » sur le côté 
gauche du Gestionnaire de fichiers en 
bas ou près du bas ?

Cliquez dessus et vous verrez « Or-
dinateur ». Il s’agit de l’emplacement 
du système racine. Cliquez sur Ordina-
teur, côté droit, et vous verrez une 
série de dossiers. Cherchez-en un qui 
dit « usr » et double-cliquez dessus. Dans 
« usr », cherchez « share » et double-
cliquez dessus. Maintenant, faites un 
double clic sur « applications ». C’est 
ici que vous verrez la plupart, voire la 
totalité, de vos fichiers « desktop » :

Ces fichiers contiennent des infor-
mations pour les applications qu’ils re-

présentent, qui peuvent s’utiliser pour 
créer l’icône du bureau. Puisque j’aime 
jouer aux échecs, faisons un clic droit 
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Richard 'Flash' Adams habite dans le 
nord rural de l’Alabama et a été techni-
cien informatique, analyste opérationnel, 
vendeur de logiciels, analyste des ventes, 
chef d’une équipe de contrôle qualité et 
perdrix dans un poirier. Sa calopsitte, 
Baby, a maintenant un petit frère adop-
té, une conure à tête sombre nommée 
Skittles. 

UBUNTU AU QUOTIDIEN

sur le fichier « 3dchess.desktop » et 
sélectionnons « Copier ». Maintenant 
minimisez le Gestionnaire de fichiers 
et vous devriez voir le bureau, à moins 
qu’il faille aussi minimiser d’autres 
programmes. Une fois le bureau vi-
sible, faites un clic droit dessus et 
sélectionnez « Coller ». Le fichier aura 
l’apparence d’un engrenage générique, 
mais nous voulons voir l’icône précise 
de l’application.

Maintenant, faites un clic droit sur 
l’icône sur le bureau et sélectionnez 
« Autoriser le lancement ».

L’icône, qui était une icône générique 

d’engrenage, ressemblera à l’icône nor-
male par défaut de l’application et se-
ra exécutable. Enfin, après tout cela, il 
y a une icône pour 3DChess sur le 
bureau :

Si on veut que le bureau reste 
relativement « propre », nous pouvons 
également créer des dossiers dessus, 

en faisant un clic droit et en sélec-
tionnant « Nouveau dossier » :

Utilisez les dossiers que vous créez 
comme des catégories (par exemple, 
« Jeux » ou « Bureautique »), où vous 

pouvez placer un raccourci vers cha-
que application :

et vous pouvez aussi créer des sous-
dossiers à l’intérieur des dossiers « prin-
cipaux » pour des sous-catégories et 

organiser votre bureau de cette façon-
là. N’ayez pas peur d’apprivoiser le bu-
reau et de le faire fonctionner d’une 
façon qui répond à VOS besoins.
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DDIISSPPOOSSIITTIIFFSS  UUBBPPOORRTTSS
Écrit par l'équipe UBports
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Je préférerais un tigre 
du Bengale ! 
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D’accord, je suis vieux. Des gens 
me demandent de leur raconter 

mon voyage avec Linux, mais il faut 
remonter bien avant cela.

Quand j’étais en dernière année de 
lycée (1969), résidant dans la banlieue 
de Los Angeles, on a entendu parler 
des calculatrices de poche pour la pre-
mière fois. Nous avons ri. Qui voudrait 
payer 250 $ pour quelque chose qui 
vous aiderait pour les maths de base ? 
Mais que l’informatique ait tant pro-
gressé était une idée passionnante.

Je suis allé à la fac, à Sterling, au 
Kansas. L’école avait un ordinateur de 
taille moyenne, c’était nouveau chez 
eux et ils démarraient un cours d’in-
formatique. L’ordinateur était un Buf-
falo, je pense, mais c'était peut-être 
un Mohawk, et il utilisait un langage 
tout neuf, le Fortran 70. On m’a dit 
que je n’avais pas assez de crédits en 
math pour être accepté et les élèves 
dans les cours que j’aurais dû suivre 
pour rattraper mon retard étaient prin-
cipalement des athlètes, un groupe 
de gens qui aimaient toujours me ty-
ranniser ; ce n’était pas du tout diffé-
rent dans cette école-là. Mais j’avais 
un ami dans le département d’infor-

matique et on m’y faisait entrer secrè-
tement de temps en temps pour jouer 
à l’un des deux jeux sur le système – 
Star Trek et Hammurabi. Je n’ai jamais 
pu jouer beaucoup à Star Trek et ne 
me souviens même pas des règles de 
base de ce jeu.

Mon intérêt pour les ordinateurs a 
continué sur à peu près le même che-
min que ma vie : ça me fascinait tou-
jours, mais je n’osais jamais m'y lancer 
à fond. En 1978, j’ai suivi un cours sur 
BASIC dans une fac mineure en Ala-
bama (Alexander City State Junior Col-
lege, Alex City). J’ai terminé les 6 pre-
mières leçons (sur 9) avec d’excellentes 
notes, mais la leçon 7 nécessitait une 
connaissance de la trigonométrie et je 
n’en avais pas. Puisque j’avais été in-
supportable pendant les 6 premières 
leçons, personne ne voulait m’aider. À 
la fin du cours,je n'avais pas tout fait, 
mais le professeur m’a donné un 10/20 
quand même (mes autres cours n'étaient 
pas complets aussi, avec un INC et un 
5/20). C’était dû en partie à mon sen-
timent de découragement quand je 
n’arrivais pas à terminer le cours de 
BASIC, et puis cela me coûtait trop 
cher de faire l’aller-retour à l’école avec 
mon maigre salaire. J’ai même souvent 

fait du stop quand je n’avais pas assez 
d’argent pour l’essence, mais c’était trop 
déprimant et j’ai tout abandonné.

Avance rapide à la deuxième fois 
où je vivais à Denver (la première fois 
était de 1973 à 1978, et la seconde en 
1980-1990). Je venais de recevoir une 
somme d’argent, je ne me souviens pas 
pourquoi, et il n’y avait vraiment rien 
que j’étais forcé de faire avec. Alors 
que j’aurais pu le garder ou quelque 
chose comme ça, je suis entré dans un 
magasin qui vendait des ordinateurs 
Texas Instruments TI99/4A pour 165 $, 
y compris un magnétophone à cas-
sette, deux cartouches de jeux et deux 
manettes. Bien que les jeux ne m’inté-
ressent pas vraiment, je savais que je 
voulais faire de l’informatique. J’ai acheté 
ce système… et j’ai découvert que le 
BASIC utilisé était un peu sommaire, 
mais j’ai réussi au moins à recréer cer-
tains de mes meilleurs programmes 
de la fac. Mais, pour progresser, j'avais 
besoin de lecteurs de disques. Cela 
nécessitait l’Expansion Box, qui coûtait 
400 $ vide - les lecteurs étaient en plus. 
Je n’ai jamais réussi à franchir ce cap-là 
et, finalement, j’ai mis le TI au rebut.

À cette époque, j’avais également 

une amie qui a obtenu l’autorisation 
que je travaille dans son bureau, l’Edu-
cation Commission des States, et que 
je m’exerce sur le traitement de texte 
qu’ils utilisaient, un NBI. C’était très 
amusant et m’a éloigné de la seule uti-
lisation d’une machine à écrire. (Mon 
écriture était si mauvaise qu'en 5e, 
j'étais dispensé d’un cours obligatoire 
pour que je puisse avoir un semestre 
de Dactylographie. Depuis lors, je n’uti-
lise qu’un clavier et c’était vers 1965.)

En 1986 ou 87, j’ai rencontré une 
femme avec laquelle j’ai finalement 
emménagé et que j’ai épousée. Elle 
était ingénieur en contrôle qualité chez 
Digital Electronics à Colorado Springs. 
De temps en temps, elle faisait du 
télétravail et je pouvais utiliser son 
terminal VT-102 et le modem à 2 400 
bauds quand elle n’était pas à la mai-
son. J’entrais dans le groupe d’ordi-
nateurs VAX qu’elle administrait avec 
le modem... et jouais à Hack, une va-
riante de Rogue. (Je joue toujours à 
Nethack, une version mise à jour.) Puis, 
je me suis impliqué dans le monde des 
BBS (échange de messages et fichiers) 
et un opérateur de serveur local me 
prêtait un IBM 5150 dont il n’avait pas 
besoin. (Je l'ai acheté, finalement.) Cette 

MMOONN  HHIISSTTOOIIRREE
Écrit par Moss Bliss
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machine avait le processeur célèbre, 
le 8088 à 4,77 MHz, était livré à l’ori-
gine avec 256 Ko de RAM sur la carte 
mère et deux lecteurs de disquette 
5,25 pouces à pleine hauteur et à dou-
ble densité. L’un des lecteurs de dis-
quettes avait été remplacé par un lecteur 
de disquettes 5,25 pouces, à demi-hau-
teur et à haute densité, et un disque 
dur de 10 Mo ; il y avait également 
une carte qui étendait la capacité de la 
RAM à 640 Ko (elle pouvait aller en 
fait jusqu’à 720 Ko, mais DOS ne savait 
gérer que 640 Ko et quelques empla-
cements de puces étaient laissés vides). 
J’exécutais alors DOS 3.1 et je faisais 
beaucoup de choses avec le BBS en 
utilisant Fidonet (j’ai aussi utilisé des 
Mustang BBS, mais ils ne me plaisaient 
pas). J’ai également réussi à échanger 
mon disque dur de 10 Mo, avec 100 $, 
pour un disque dur de 30 Mo. Que 
ferai-je de tout cet espace ???

En 1990, je suis allé vivre dans le 
Michigan. À la bibliothèque municipale, 
j’ai trouvé par hasard la 11e édition du 
Secret Guide to Computers (en 3 volumes 
à cette époque). Il m’a fasciné et j’ai 
presque toutes les éditions qu’ils ont 
publiées, de la 18e jusqu’en 2015, l’an-
née où j’ai remarqué que Russ Walter 
ne voulait pas parler de Linux. À cause 
de ça, ce guide n’était plus aussi utile 
pour moi. Je recommande fortement 
ce livre pour les nouveaux utilisateurs 

et vous en trouverez la plupart gratui-
tement en ligne à https://secretfun.com.

Il n'a pas fallu longtemps avant que 
j’aie besoin d’une mise à niveau. J’ai dé-
couvert que les 5 fentes d’expansion 
dans mon boîtier 5150 étaient déjà 
obsolètes, car les nouveaux ordina-
teurs avec un 80286 avaient 8 fentes 
et les nouvelles cartes mères n’allaient 
pas dans mon vieux boîtier. J’ai réussi 
à obtenir un nouveau boîtier, une carte 
mère et quelques autres composants 
et à migrer mes cartes, lecteurs et 
périphériques dans la nouvelle boîte. 
Ainsi, j’avais assemblé un ordinateur 
pour la première fois en 1989 ou à peu 
près. J’exécutais DOS 3.3 et venais de 
découvrir une unité d’extension de DOS 
appelée 4DOS qui était prometteuse 
et faisait tourner WordPerfect 5.

À partir de là, j’utilisais des clones 
de PC. Dans un boulot, j’étais forcé 
d’utiliser Windows 2 Runtime et c’était 
vraiment mauvais, mais meilleur que 
GEM Desktop. J’ai déménagé plusieurs 
fois et je mettais à niveau mon ordina-
teur ou j'en achetais d’occasion que je 
pouvais payer. Je me souviens d’une 
machine 386 et d’une 486 DX/2 que je 
gardais quand j’ai « déménagé » à Ashe-
ville en Caroline du nord en 1998 (j’y ai 
eu un accident de voiture et je n’avais 
aucune raison de repartir... c’est une 
longue histoire).

C’était l’époque où je me lassais déjà 
de Windows et je commençais à envi-
sager Linux. Je ne sais pas quand j’ai 
obtenu le livre Red Hat 5.1 ou l’exem-
plaire de Slackware, mais ils étaient 
trop intimidants pour que je les essaie. 
J’ai toujours été un peu timide et, com-
me je l’ai dit, j’avais tendance à laisser 
la vie mener ma vie plutôt que de sauter 
dedans à pieds joints. ce fut le cas 
quand j’ai eu un exemplaire de Man-
drake en 2002 et il s'est installé sur ma 
machine sans que je doive entrer le 
numéro de série de tous les dispositifs 
internes ! Oui, il s’est installé tout sim-
plement et a tout trouvé et j’étais très 
heureux. Ce n’était pas assez bon pour 
remplacer Windows étant donné que 
je suis un utilisateur typique qui, pour 
la plupart, va sur le Net et fait du trai-
tement de texte, ni codeur, ni joueur 
(au fil de ma vie j’ai remarqué que les 
joueurs ont toujours des équipements 
très chers que je ne pouvais pas me 
permettre). Ensuite, je fus déçu quand 
une mise à niveau de Mandrake a 
refusé de s’installer sur ma machine. Pas 
longtemps après, j’ai trouvé un exem-
plaire de SuSE Linux (peu de temps 
avant la création d’openSuSE) et il fonc-
tionnait assez bien, mais, à nouveau, 
c’était l’heure du double amorçage et 
pas tout à fait le moment d’abandon-
ner Windows complètement.

En 2006, je gérais Asheville Home-

less Network (Réseau pour les SDF 
d’Asheville) et j’ai utilisé une partie des 
sommes recueillies pour acheter quel-
ques Asus EeePC pour les membres 
les plus courageux afin qu’ils puissent 
vivre mieux et chercher du travail plus 
facilement. Ces ordinateurs étaient sous 
Linux, ce que je voulais vraiment. Je 
ne sais plus ce que j’avais à la maison à 
l’époque, mais j’étais sans doute en 
double amorçage avec une version quel-
conque de Linux. D’abord, on a pris les 
modèles 701, puis, quand ils s’avéraient 
trop petits pour certains membres, on 
a acheté des 901.

À un certain moment, quand j’en 
avais vraiment assez de Windows, je 
suis retourné à Linux. Cette fois-là, j’ai 
choisi Ubuntu. Je pouvais l’utiliser pour 
tout ce dont j’avais besoin et j’ai donc 
arrêté le double amorçage sans trop 
attendre. Je me suis inscrit sur Linux-
Questions le 14/03/08 et sur Ubuntu 
Forums (avec Ubuntu One) le 12/03/08. 
J’étais content jusqu’à ce que, avec la 
12.04, ils passent au bureau Unity. La 
12.04 ne voulait pas s'installer sur 
mon ordinateur et, bien que des gens 
me disent sans cesse qu’on pouvait 
installer la 12.04 avec un autre bureau, 
rien ne fonctionnait. Je suis donc re-
tourné sous Windows 7. À ce stade, je 
vivais à Blaine au Tennessee, la pre-
mière de trois adresses dans cette ville. 
Je suis allé vivre à Knoxville pendant 

https://secretfun.com
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un an et j’ai acheté deux ordinateurs 
sous Windows 8, qui se sont mis à ni-
veau sous la 8.1. Je n’étais pas heu-
reux. Quand je suis retourné à Blaine, 
j’avais un ordinateur de bureau Dell 
sous Windows 7 et je ne me souviens 
même pas de ce qui est arrivé aux 
portables sous Win8. Puis Windows me 
poussait et me poussait à faire la mise 
à niveau vers Windows 10. Je l’ai faite. 
J’ai vu tous les problèmes sécuritaires 
dont parlaient les gens. J’ai fermé tous 
les trous qu’il m'était possible de fer-
mer et j’ai trouvé qu’il y en avait que je 
ne pouvais pas fermer. Je suis revenu 
sous Windows 7 et j’ai découvert que 
les trous ouverts dans Windows 10 y 
étaient encore. Je me suis donc fâché. 
J’ai téléchargé Linux Mint 17 et sup-
primé Windows. À tout jamais.

Je fais tourner Mint depuis, sans 
aucune influence de Microsoft dans 
ma vie (j’ai remplacé Microsoft Office 
par SoftMaker Office en 2008, pen-
dant que j’étais encore sous Windows, 
et je l’ai gardé quand j’ai migré vers 
Linux). J’étais vraiment impressionné 
par le chemin fait par Linux avec Linux 
Mint 17, et j’ai commencé à regarder 
d’autres distrib. pour voir si elles avaient 
progressé autant. Je trouve que c’est 
le cas pour la plupart et, dans ma vie 
en multiple amorçage, je ne cesse de 
sauter de distrib. en distrib. pour les 
examiner.

En août 2018, j’ai entendu dire que 
mintCast cherchait de nouveaux hôtes. 
J’ai répondu à l’appel sans avoir de 
connaissances préalables sur ce que 
j’allais faire et Rob Watkins a accepté 
mon application. Bien entendu, il a ac-
cepté TOUTES les applications et à 
créé des réunions en ligne pour former 
la nouvelle équipe – quiconque pou-
vait se présenter serait engagé. Il est 
impossible de vous dire combien j’ai 
appris pendant mon temps sur mint-
Cast, à la fois de notre émission et 
aussi d’avoir écouté tant d’autres bons 
podcasts sur Linux. Et, à un certain mo-
ment, le fait que des gens m’appe-
laient un « sale sauteur de distrib. en 
distrib. » m’a donné la motivation de 
doubler la mise. J’ai parlé à Tony Hughes, 
l’autre hôte de mintCast, et, avec son 
aide (je n’aurais pas pu le faire sans 
lui), j’ai démarré le podcast Distro-
hoppers’ Digest en avril 2019.

Cet essai ne contient pas beau-
coup d'événements de ma Vraie Vie. 
Mon épouse actuelle est la sixième, 
j’ai une longue et satisfaisante, mais 
vraiment mauvaise, carrière dans la 
musique (un CD est disponible sur 
https://mordewis.bandcamp.com), et 
j’ai eu plus d’adresses que certaines 
personnes n’ont eu de paires de chaus-
sures. Je me suis bien éclaté avec à 
peine assez de réussite pour rester en 
vie. Je n’ai pas non plus parlé des foules 

de tablettes et téléphones que j’ai 
eus, mais nous savons tous que An-
droid_is_not_Linux [Marque déposée].

J’espère que ces souvenirs du bon 
vieux temps vous ont plu. Ils com-
portent forcément des oublis et des 
inexactitudes, parce que la mémoire 
n’est pas ma meilleure caractéristique.

https://mordewis.bandcamp.com
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Lignes directrices

N otre seule règle : tout article doit avoir 
un quelconque rapport avec Ubuntu 

ou avec l'une de ses dérivées (Kubuntu, 
Xubuntu, Lubuntu, etc.).

Autres règles
••Les articles ne sont pas limités en mots, mais 
il faut savoir que de longs articles peuvent 
paraître comme série dans plusieurs numéros.

• Pour des conseils, veuillez vous référer au 
guide officiel Official Full Circle Style Guide ici :
http://bit.ly/fcmwriting

• Utilisez n'importe quel logiciel de traite-
ment de texte pour écrire votre article – je 
recommande LibreOffice –, mais le plus impor-
tant est d'en VÉRIFIER L'ORTHOGRAPHE ET 
LA GRAMMAIRE !

• Dans l'article veuillez nous faire savoir l'em-
placement souhaité pour une image spéci-
fique en indiquant le nom de l'image dans un 
nouveau paragraphe ou en l'intégrant dans le 
document ODT (OpenOffice/LibreOffice).

• Les images doivent être en format JPG, de 
800 pixels de large au maximum et d'un niveau 
de compression réduit.

• Ne pas utiliser des tableaux ou toute sorte 
de formatage en gras ou italique.

Lorsque vous êtes prêt à présenter 
l'article, envoyez-le par courriel à :

 articles@fullcirclemagazine.org.

Si vous écrivez une critique, veuillez 
suivre ces lignes directrices :

Traductions
Si vous aimeriez traduire le Full Circle 

dans votre langue maternelle, veuillez en-
voyer un courriel à ronnie@fullcirclema-
gazine.org et soit nous vous mettrons en 
contact avec une équipe existante, soit 
nous pourrons vous donner accès au texte 
brut que vous pourrez traduire. Lorsque 
vous aurez terminé un PDF, vous pourrez 
télécharger votre fichier vers le site prin-
cipal du Full Circle.

Auteurs francophones
Si votre langue maternelle n'est pas l'an-
glais, mais le français, ne vous inquiétez 
pas. Bien que les articles soient encore 
trop longs et difficiles pour nous, l'équipe 
de traduction du FCM-fr vous propose de 
traduire vos « Questions » ou « Courriers » 
de la langue de Molière à celle de Shake-
speare et de vous les renvoyer. Libre à vous 
de la/les faire parvenir à l'adresse mail ad 
hoc du Full Circle en « v.o. ». Si l'idée de 
participer à cette nouvelle expérience vous 
tente, envoyez votre question ou votre 
courriel à :

webmaster@fullcirclemag.fr

Écrire pour le FCM français
  Si vous souhaitez contribuer au FCM, mais 
que vous ne pouvez pas écrire en anglais, 
faites-nous parvenir vos articles, ils seront 
publiés en français dans l’édition française du 
FCM. 

CRITIQUES

Jeux/Applications
Si vous faites une critique de jeux ou d'applications, veuillez noter 
de façon claire :

••le titre du jeu ;
••qui l'a créé ;
••s'il est en téléchargement gratuit ou payant ;
••où l'obtenir (donner l'URL du téléchargement ou du site) ;
••s'il est natif sous Linux ou s'il utilise Wine ;
••une note sur cinq ;
••un résumé avec les bons et les mauvais points.

Matériel
Si vous faites une critique du matériel veuillez noter de façon claire :

••constructeur et modèle ; 
••dans quelle catégorie vous le mettriez ; 
••les quelques problèmes techniques éventuels que vous auriez ren-
contrés à l'utilisation ; 
••s'il est facile de le faire fonctionner sous Linux ; 
••si des pilotes Windows ont été nécessaires ; 
••une note sur cinq ; 
••un résumé avec les bons et les mauvais points.

Pas besoin d'être un expert pour écrire un 
article ; écrivez au sujet des jeux, des 
applications et du matériel que vous utilisez 
tous les jours.

http://bit.ly/fcmwriting
mailto:articles@fullcirclemagazine.org
mailto:ronnie@fullcirclemagazine.org
mailto:webmaster@fullcirclemag.fr
mailto:ronnie@fullcirclemagazine.org
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CCRRIITTIIQQUUEE
Écrit par Gabriele Tettamanzi GGaalllliiuummOOSS  33..11

E n 2014, j'ai acheté un Asus C300, 
avec un processeur Intel Celeron 

N2840 à 2 cœurs et à 2,16 GHz, 4 Go 
de RAM, 32 Go de stockage interne, 
l'architecture Bay Trail QUAWKS, sous 
Google ChromeOS.

Après un peu d’enthousiasme à l'ori-
gine, surtout par rapport à sa légèreté 
et la très longue durée de vie de la 
batterie, je ne l'utilisais presque plus : 
même si j'y ajoutais quelque tours de 
magie Linux en installant Crouton, 
c'était en fait un système de naviga-
tion Web.

Il y a quelques mois, le support de 
ChromeOS pour ce modèle a atteint 
sa fin de vie et le moment était venu 
de rafraîchir cette petite machine avec 
un nouveau système d'exploitation.

J'ai décidé d'éliminer ChromeOS et 
d'installer un nouveau système d'ex-
ploitation. Ainsi, afin d'activer le démar-
rage EFI et de profiter pleinement du 
matériel, j'ai enlevé la vis de protec-
tion en écriture et j'ai flashé un nou-
veau firmware avec le script utilitaire pour 
firmware de MrChromebox (https://
mrchromebox.tech/). Par ailleurs, les 
outils de MrChromebox valent le coup 

d'être signalés : ils sont géniaux, la do-
cumentation est claire comme de l'eau 
de roche et les composants logiciels 
fonctionnent parfaitement.

Par la suite, j'ai testé de nombreuses 
distrib. de premier plan ; toutefois, 
chaque distrib. que j'ai testée, sans 
exception, avait le même problème prin-

cipal : la carte son interne ne fonc-
tionnait pas.

Finalement, une recherche sur le 
Web m'a aiguillé vers GalliumOS, la 
distrib. dédiée précisément aux Chrome-
books et Chromeboxes.

GalliumOS 3.1 est basée sur Ubun-

tu 18.04 et propose l'environnement 
de bureau Xfce, qui apporte un coût 
limité en terme de ressources et une 
grande flexibilité pour le paramétrer 
aux goûts et aux besoins de chacun ; 
l'équipe mise sur neuf variantes diffé-
rentes de la distrib. pour neuf archi-
tectures différentes de Chromebooks 
et Chromeboxes.

https://mrchromebox.tech/
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CRITIQUE
J'ai testé l'ISO de Bay Trail qui est 

spécifiquement pour GalliumOS et tout 
fonctionnait à peu près dans le sys-
tème live, même si le volume de la 
carte son interne était très bas à la 
fois sur le casque et sur les haut-
parleurs.

Sur le site Web officiel (https://gal-
liumos.org) se trouve une section de 
documentation qui, à part d'autres in-
formations, donne des directives très 
précises concernant le processus d'ins-
tallation, qui peut être en double amor-
çage avec ChromeOS, une installation 
complète de l'ISO, ou une installation 
sur une machine virtuelle.

Comme prévu, j'ai choisi l'installa-
tion complète de l'ISO.

L'installeur, Ubiquity, est le même 
que dans Ubuntu 18.04, sauf le nom ; il 
peut être démarré à partir de l'envi-
ronnement live.

Après une mise à jour du nouveau 
système et un redémarrage, GalliumOS 
utilisait environ 395 Mo, à peu près 0,5 
% de mon petit processeur et environ 
5 Go de stockage interne ; après avoir 
installé les quelques applications dont 
j'avais besoin, il utilisait environ 6 Go 
sur les 32 Go disponibles dans le stoc-
kage interne.

Il était possible de choisir une dis-
position du clavier qui activait les 
touches F sur la première rangée de 
touches, qui contrôlent le volume, la 
luminosité, les écrans, etc., et une 
seconde fonction activée par la touche 
rechercher, dans mon cas (la touche 
de chevauchement).

Le pavé tactile fonctionne avec flui-
dité, le clic droit est mappé comme on 
tape avec deux doigts. Les deux, le 
mappage du clavier et la configuration 

du pavé tactile, sont des fonctionna-
lités précieuses ajoutées par l'équipe 
de GalliumOS.

Il y a quelques thèmes spécifiques 
à GalliumOS, y compris des icônes et la 
décoration des fenêtres, et le compo-
siteur Compton tourne sous le capot 
pour donner une interface utilisateur 
agréable et sans déchirure. J'ai ajusté 
les paramètres de Compton dans son 
fichier de configuration afin d'ajouter 
un peu de transparence aux cadres 

des fenêtres et aux fenêtres inactives.

Le nombre d'applications pré-ins-
tallées est extrêmement limité, ce qui 
fait que le système est léger ; par 
exemple, ni des applications de bu-
reautique, ni des jeux ne sont pré-ins-
tallés.

Il y a deux gestionnaires de pa-
quets en interface graphique : Synap-
tic, qui est bien connu, et AppGrid, une 
boutique visuelle de logiciels où les 

https://galliumos.org/
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diverses applications sont présentées 
dans un grid (ou grille), comme le nom 
le suggère. J'ai l'habitude d'utiliser le 
terminal pour gérer les paquets, mais 
s'il fallait choisir entre AppGrid et Sy-
naptic, ma préférence irait à Synaptic, 
le plus réactif et de loin. Gdebi est 
également disponible,  utile pour ins-
taller des paquets de sources autres 
que celle gérées par apt.

MenuLibre est pré-installé afin d'ac-
tiver la personnalisation du menu, il y 
a le visionneur d'image Ristretto et 
Atril comme lecteur PDF.

Deux lecteurs de média sont dis-
ponibles, Audacious pour les fichiers 
audio et Mpv pour les vidéos.

Chromium est le navigateur ins-
tallé et les bons outils habituels de 
Xfce s'y trouvent aussi : le menu Whis-
kers, le gestionnaire de fichiers Thunar, 
Catfish pour la recherche de fichiers, 
l'émulateur Xfce Terminal et le ges-
tionnaire de paramètres Xfce ; à l'in-
térieur de celui-ci, se trouve le dernier, 
le gestionnaire de panneaux, qui pro-
pose différentes dispositions pré-orga-
nisées avec un ou deux panneaux.

Dès l'installation, GalliumOS 
affiche un bureau léger, avec une 
barre de menus en bas et aucune 
icône sur le bureau. L'ensemble de 

logiciels pré-installés est essentiel ; j'y 
ai ajouté neofetche et htop (des uti-
litaires en ligne de commande), l'éditeur 
d'images Gimp, qbittorrent (un client 
torrent), Olive (un éditeur de vidéos), 
LibreOffice (la suite bureautique), Jo-
plin (un outil pour prendre des notes) 
et le navigateur Web Chrome pour le 
compléter. Oracle Virtualbox, que j'ai 
installé et utilisé pour l'émulation d'An-
droid (voir ci-dessous) fonctionne, mais, 
bien entendu, il souffre de la per-
formance limitée du matériel. Des pa-
quets snap fonctionnent, tout en étant 
beaucoup plus lents, surtout au dé-
marrage, que les paquets installés.

Je suis vraiment pas joueur et nous 
ne pouvons pas nous attendre à voir 
de hautes performances d'un ordina-
teur comme celui-ci. J'ai cependant tes-
té Super Tux Kart, qui fonctionne bien.

Le projet, y compris le traçage de 
bug, est sur Github et il y a une com-
munauté amicale sur le canal Reddit, r/
GalliumOS. Un canal IRC existe aussi, 
mais je ne l'ai jamais testé.

Jusqu'ici, après deux semaines d'usa-
ge, j'ai eu des problèmes avec la carte 
son interne et je ne pouvais pas utili-
ser mon smartphone en mode USB. 
Voici quelques détails concernant les 
problèmes de la carte son : dès l'instal-
lation, le microphone du casque ne fonc-

tionnait pas et le volume de la carte 
son interne était faible. J'ai corrigé les 
deux en éditant le fichier de configu-
ration (HiFi.conf) de la carte. Qui plus 
est, GalliumOS est livré avec un agréa-
ble applet d'interface pour pulse audio 
dans le panneau, nommé pastray, qui 
s'est avéré être la cause des crépite-
ments ou de la soudaine désactivation 
du son. Je l'ai remplacé par l'applet 
standard du volume dans Xfce et le 
problème a disparu.

J'ai essayé d'installer des émula-
teurs d'Android (Anbox, Genymotion et 
AndroidX86), car je voulais faire tour-
ner des applis Android. Mais le ma-
tériel est trop faible pour les faire 
tourner convenablement. Et, pour être 
honnête, je n'avais pas le support des 
applis Android sous ChromeOS et je 
n'en ai pas besoin.

Il se peut que d'autres distributions 
soient plus élégantes que GalliumOS, 
mais l'expérience est globalement 
très bonne, avec un démarrage rapide, 
de la réactivité, une interface agréable 
et une longue durée de vie de la bat-
terie. ChromeOS ne me manque pas 
du tout.

AVANTAGES :

••la distrib. est faite sur mesure pour 
le Chromebooks et Chromeboxes,
••l'interface utilisateur est très réac-
tive,
••l'utilisation des ressources, y compris 
le stockage interne, est très limitée,
••très bonne prise en charge du ma-
tériel comparée à d'autres distrib.,
••une large collection de logiciels.

INCONVÉNIENTS :

••des problèmes dès l'installation avec 
la carte son interne, mais cela semble 
concerner uniquement mon matériel,
••elle utilise un noyau GalliumOS, qui, 
apparemment, n'est pas connecté au 
système de maintenance du noyau 
d'Ubuntu 18.04.
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CCOOUURRRRIIEERRSS
Si vous voulez nous envoyer une lettre, une plainte ou 
des compliments, veuillez les envoyer, en anglais, à : 
letters@fullcirclemagazine.org. NOTE : certaines lettres 
peuvent être modifiées par manque de place. 

Rejoignez-nous sur :

facebook.com/
fullcirclemagazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/
forumdisplay.php?f=270

LE FCM A BESOIN DE 
VOUS ! 

Sans les contributions des lec-
teurs le magazine ne serait 

qu'un fichier PDF vide (qui n'inté-
resserait pas grand monde, me sem-
ble-t-il). Nous cherchons toujours 
des articles, des critiques, n'importe 
quoi ! Même des petits trucs com-
me des lettres et les écrans de bu-
reau aident à remplir la revue. 

Voyez l'article Écrire pour le FCM 
dans ce numéro pour lire nos di-
rectives de base. 

Regardez la dernière page de n'im-
porte quel numéro pour les détails 
sur où envoyer vos contributions.

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
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QQ..  EETT  RR..
Compilées par EriktheUnready

Si vous avez des questions sur Ubuntu, envoyez-les en anglais à : 
questions@fullcirclemagazine.org, et Erik y répondra dans un prochain numéro. 
Donnez le maximum de détails sur votre problème. 

B ienvenue de retour dans un autre 
épisode de Questions et Réponses ! 

Dans cette rubrique, nous essaierons 
de répondre à vos questions sur Ubuntu. 
Assurez-vous d’ajouter les détails de 
la version de votre système d’exploi-
tation et de votre matériel. J’essaierai 
d’enlever des questions toutes chaînes 
qui pourraient vous identifier person-
nellement, mais il vaut mieux ne pas 
inclure des choses comme les numé-
ros de série, UUID ou adresses IP. Si 
votre question n’est pas publiée tout 
de suite, ce n’est que parce qu’il y en a 
beaucoup et je les fais sur la base de « 
premier venu, premier servi ».

À  une époque, je travaillais pour une 
société d’automatisation. Le roule-

ment des comptables était élevé. As-
sez bizarrement, les comptables étaient 
des antiquités, mieux que du pop-corn 
au cinéma (bon, je ne dis pas que le pou-
voir gris n’existe pas, mais je pense 
que certains d’entre eux n’avaient mê-
me pas déjà vu un ordinateur). Com-
me la société n’avait pas de dépar-
tement informatique, elle utilisait l’un 
des autres services, qui était en fait 
une autre entreprise où je travaillais. 
Le seul comptable qui a pris sa retraite 
de notre société de comptabilité pré-
cédente est venu travailler pour nous. 

Cependant, le gris ne faisait que couvrir 
le blond. Je recevais quotidiennement 
des appels à propos d'imprimantes. 
Cette personne précise n’arrivait pas à 
comprendre les imprimantes. Elle im-
primait des choses jusqu’à ce que le 
bac de sortie fût plein et, quand l’im-
pression s’arrêtait (ou qu'il n’y avait 
plus de papier), elle appelait l’assis-
tance. (Parfois le même document était 
imprimé 500 fois, mais ce n’était « ja-
mais sa faute, mais celle de l’ordina-
teur »). Quel que soit le nombre de 
fois où je lui montrais pourquoi l’im-
pression s’arrêtait, et qu’il fallait en-
lever le papier au bon moment, elle 
faisait la sourde oreille. Elle ne savait 
pas faire la distinction entre les impri-
mantes étiquetées « comptabilité » 
et « couloir » et « bureau de des-
sins » (même après plusieurs séances 
où je lui expliquais que « comptabilité » 
était pour les documents confidentiels, 
« couloir » était pour les tirages énormes 
et « bureau de dessin » était destiné 
aux tailles bizarres et aux dessins.) En-
fin, cette personne était responsable 
de l’impression des salaires sur l’impri-
mante du couloir et celle du bureau 
de dessins, encore et encore, car cela 
ne sortait pas sur celle de la compt-
bilité.  En retour, cela a débouché sur 
la démission en masse de presque la 

moitié du personnel. Parfois, vous ne 
pouvez pas corriger les bêtises hu-
maines et les gens blâmeront les sys-
tèmes informatiques, bien que lesdits 
systèmes fonctionnent comme prévu.

Q  : Vaut-il la peine d’obtenir un 
Latte Panda ?

R  : Non. Vous pouvez acheter deux 
portables, avec de plus puissants 

processeurs, pour moins qu’un Latte Pan-
da (peut-être que si le prix baisse ?).

Q  : Les gars, j’ai Linux Mint et j’es-
saie de mettre à niveau vers la 

dernière version de lightzone via le PPA, 
mais je n’y arrive pas. Il ne veut pas re-
connaître le PPA. Pouvez-vous m’aider ?

R  : Pour faire court : il vous faut une 
autre version de Mint. LMDE ne 

fonctionne pas avec des PPA. Si vous 
voulez garder la version Debian, il faut 
la compiler à partir des sources.

Q  : J’ai un ordinateur portable Le-
novo 80L0 sous Xubuntu 18.04 et 

je trouve que le ventilateur se met en 
marche très souvent. J’ouvre le ges-

tionnaire de tâches et je vois que gluqio 
exécute plus d’une instance, chacune 
utilisant 15-20 % de mes deux proces-
seurs. Je ne trouve rien dans les pages 
man et, quand je tape glu, puis le ta-
bulateur deux fois, il  n’y a aucun ré-
sultat. Est-ce que j’ai des maliciels et 
comment m’en débarrasser ?

R  : En fait, il s’agit de gluqlo, qui fait 
partie des économiseurs d’écran, 

une horloge à palettes IIRC. Xubuntu a 
souvent des problèmes avec les éco-
nomiseurs d’écran qui se bloquent ou 
ne s’arrêtent pas quand vous bougez 
la souris ou tapez sur une touche. Le 
processus n’est pas critique et vous 
pouvez le tuer.

Q  : Je suis peut-être bête, mais je 
n’arrive pas à me débarrasser des 

polices spaghetti sur mon système. Si 
j’ouvre l’application des polices, elle 
liste toutes les polices, mais je ne vois 
qu’un bouton info. La touche Suppr 
n’a aucun effet. Il n’y a pas de clic droit. 
L’ouvrir en tant que root n’a aucun 
effet.

R  : L’application des polices ne sert 
qu’à vous montrer à quoi res-

semblent les polices qui sont installées ; 

mailto:questions@fullcirclemagazine.org
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Q. ET R.
il faut installer un gestionnaire des po-
lices si vous voulez en supprimer.

Q  : J’ai installé sublime text sous 
Ubuntu pour pouvoir suivre un 

tutoriel, mais si j’essaie de le lancer à 
partir de la ligne de commande – 
j’essaie sublime ou sublimetext – tout 
ce qui s’affiche est « sublime: com-
mand not found » (commande introu-
vable). Je n’ai mis à niveau à partir de 
Windows que récemment, et suis donc 
encore hésitant.

R  : Je ne sais pas pourquoi vous de-
vriez lancer Sublime Text à partir 

de la ligne de commande, mais la com-
mande est tout simplement : 

subl 

Q  : Ma question est en deux parties. 
Comment faire en sorte que le 

centre de logiciels affiche tout concer-
nant le développement Web ou Java 
dans un seul endroit. Comment les 
regrouper ou créer ma propre dispo-
sition ? Les outils de développeur me 
donnent seulement « all » ou « ide ». 
Ce n’est pas l’idéal. Puis, parfois je fais 
des mises à jour à partir du gestion-
naire de mises à jour et, une fois 
faites, je vais dans le Centre de logi-
ciels et il y a une mise à jour que le 
gestionnaire de mises à jour n’a pas 
montrée. Comment est-ce possible ?

R  : OK, la première partie : à ma 
connaissance, c’est impossible, 

mais vous pouvez installer « appgrid » 
qui permet davantage de catégories 
et de sous-catégories que le centre de 
logiciels. Sa catégorie développement 
a comme sous-catégories des langages. 
Le seul hic est qu’il faut les faire dé-
filer avec les flèches sur la droite. Je 
ne sais même pas si le défilement avec 
la souris est pris en charge. La deuxiè-
me partie : je dirais que la mise à jour 
est arrivée tout de suite après celle 
que vous avez faite ? J’utilise la ligne 
de commande pour mes mises à jour 
et ne peux donc pas témoigner des 
versions en interface graphique, mais 
c’est la seule chose qui me vient à 
l’esprit qui pourrait en être la cause, 
car toutes les mises à jour ne sont pas 
publiées en même temps.

Q  : Je n’arrive pas à trouver une 
version de la 20.04 en 32-bit. Je 

vois qu’il a été abandonné. J’ai un por-
table Acer avec Ubuntu 32-bit et avais 
l’intention de mettre à niveau dès la 
publication de la nouvelle version LTS. 
Pour une raison que je ne comprends 
pas, je ne peux pas charger la 64-bit, 
car elle se plante toujours, mais la 32-
bit fonctionne. Mes spécifs : CPU : 
T2250, RAM : 2 Go.

R  : C’est vraiment très étrange, puis-
que cette machine devrait prendre 

en charge la 64-bit. Il vous faudra ob-
tenir un « Ubuntu spin » en 32-bit, 
pour profiter des bonnes choses de la 
20.04 (si c’est possible). À ce stade, je 
ne peux pas vous dire lequel, mais gar-
dez les yeux ouverts pour l’arrivée d’un 
respin 32-bit.

Q  : Je pensais que je ne devrais pas 
apprendre Python parce que tout 

le monde essaie de l’apprendre. Je veux 
créer des programmes rapides. En plus, 
je voudrais être un programmeur pro. 
Ainsi, j’ai choisi Rust. Pensez-vous que 
j’ai tort de penser comme cela ? Rust 
m’enseignera-t-il ce qui se passe en cou-
lisses ? J’ai entendu dire que Python ne 
sait pas enseigner cela.

R  : Ouf. Je ne suis pas programmeur, 
mais voici : les deux, Python et 

Rust, sont des langages de program-
mation de haut niveau et ne vous 
apprendront pas vraiment ce qui se 
passe « en coulisses ». Pour cela, vous 
devez apprendre assembler, qui écrira 
les programmes les plus rapides éga-
lement. Cependant, n’oubliez pas Py-
thon. Allez-y et apprenez Rust, car il 
semblerait que beaucoup des « acteurs 
importants » aillent dans cette direction. 

Q  : Mon portable est un HP 14Z qui 
était livré avec un SSD de 30 Go 

pour la mise en antémémoire sous 

Windows. J’ai installé Ubuntu 20.04 
dessus et il fonctionne. Comment voir 
l’autre disque dur de 1 To mainte-
nant ?

R  : Ouvrez l’application « disques » 
si vous devez le formater. Des 

volumes qui ne sont pas initialisés ne 
s’affichent pas souvent dans le ges-
tionnaire de fichiers.

Q  : Mon portable Lenovo a dix ans 
et je voudrais exécuter lmsensors/

psensors dessus pour le surveiller, puis-
qu’il est si âgé. Le problème, c’est qu’il 
s’installe, mais n’affiche rien. Même 
pas un spot. Pas de températures, pas 
de ventilateur, rien.

R  : Microsoft. Le vendeur et Micro-
soft ont travaillé ensemble (com-

ploté ?) pour que cela ne fonctionne 
qu’avec Windows. À part écrire les 
pilotes du dispositif vous-même, attri-
buez-le à ça. Certaines choses ne peu-
vent tout simplement pas se faire. (Ce 
n’est pas mon expérience avec mes 
vieux portables Lenovo. J’utilise sen-
sors (une partie de lmsensors) avec 
Conky. - Gord)

Q  : Quelle est la meilleure façon de 
vérifier mon processeur sous Ubun-

tu ? J’ai essayé inxi, neofetch et regardé 
procinfo, mais ce n’est pas vraiment ça, 
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Q. ET R.
si vous comprenez ce que je veux dire.

R  : En fait, je ne comprends pas, mais 
si vous voulez plus de détails sur 

votre processeur, je vous suggère 
d’envisager « GPU-Z » ou « GPU-X ». 
Revenez vers moi si ce n’est pas ce 
que vous cherchez.

Q  : J’ai créé un très grand fichier 
d'hôtes sous Ubuntu. Je remarque 

que, récemment, Firefox ne respecte 
pas mon fichier d'hôtes (des domaines 
bloqués qui crachent leurs trucs ridi-
cules partout sur mes pages Web). Dois-
je changer pour Brave maintenant ou 
autre chose ?

R  : Vous ne pouvez pas avoir le 
beurre et l’argent du beurre. Soit 

vous faites confiance à votre fichier 
d'hôtes, soit vous utilisez le DNS crypté 
à l’intérieur de Firefox. J’espère que 
cela pourra être corrigé à l’avenir, mais, 
pour l’instant, c’est l’un ou l’autre. Dé-
sactivez-le dans les paramètres de Fi-
refox si vous préférez le vôtre.

Q  : J’ai eu une sorte d’échec de 
disque dans ma matrice, mais c’était 

très bon marché, et n’avait pas de lu-
mière pour désigner le disque qui est 
en panne. De toute façon, je ne peux 
pas y accéder. J’ai donc enlevé les 
disques et les ai testés l’un après 
l’autre. Maintenant, je ne me souviens 

plus de l’ordre dans lequel ils se 
placent. Y a-t-il un moyen pour moi de 
récupérer mes données ? Je suis tou-
jours sous Ubuntu 16.04...

R  : Oui, soit avec un logiciel hors de 
prix, soit l’apporter à un centre de 

récupération de données.

Q  : Ma question peut vous sembler 
bête. Comment connaissez-vous 

le PID d’un processus pour le tuer. 
Souvent dans Xubuntu, j’utilise le ges-
tionnaire des tâches pour tuer un pro-
cessus qui est bloqué, mais cela est 
finalement bloqué aussi. Comment trou-
ver le PID pour le tuer ?

R  : Je ne suis pas certain de vous 
suivre, mais je pense avoir com-

pris. Si vous vous servez d’un pro-
gramme graphique pour terminer un 
autre programme et cela ne le tue pas, 
mais semble rester là sans rien faire ? 
Eh bien, votre procédure de secours est 
d'utiliser le terminal. Vous pouvez tuer 
le processus comme sudo avec -9. De 
plus, le gestionnaire des tâches n’est 
qu’un autre processus si vous voulez le 
tuer. Vous trouverez son PID avec top 
ou htop.

Q  : J’ai installé ZorinOS sur ma ma-
chine et c’est beau. La seule chose 

qui m’agace est que, chaque fois que 
je l’utilise, il gèle ou se plante au ha-

sard. Parfois, je réussis à l’utiliser pen-
dant une heure, et parfois, une minute, 
avant qu’il ne gèle. Parce qu’il a gelé, il 
n’a pas écrit des fichiers journal non 
plus. Comment puis-je connaître la 
cause de tout cela ?

R  : Pour commencer, vous pouvez 
essayer de désinstaller java/open-

jdk/JRE, mais j’ai eu les mêmes pro-
blèmes et j’ai donc mis Zorin de côté. 
J’essaierai la prochaine version. 

Q  : S’il vous plaît, comment changer 
les paramètres audio dans 

Ubuntu Gnome pour faire fonctionner 
mon casque et mes haut-parleurs sur 
mon portable Dell 5490 ? La carte son 
est intégrée avec un jack de 3,5 mm, 
et un seul. J’ai cherché la réponse 
partout sur Google et même stack-
overflow ne peut pas m’aider.

R  : Je suis sûr que nous avons déjà 
eu cette question, mais voici : 

c'est tout simplement impossible, et 
je vous dirai pourquoi. Le portable est 
un portable d’affaires et ils ont rogné 
sur les dépenses. Le jack de 3,5 mm ne 
fait qu’interrompre le flux d’électricité 
vers les haut-parleurs. En d’autres ter-
mes, il redirige le « trafic » vers le cas-
que, physiquement (c'est-à-dire que des 
logiciels ne feraient pas de diffé-
rence). Vous devez chercher une carte 
son externe qui soit bien prise en 
charge par Linux.

Q  : Je serai bref. Actuellement, j’ut-
ilise ultraviewer pour me connec-

ter au PC Windows de ma mère.  Le 
truc, c’est que je ne veux plus garder 
une machine virtuelle Windows dans 
VMWare rien que pour ça, car VMWare 
ralentit Ubuntu 18.04 énormément. 
Ma machine a 8 Go de RAM, mais le 
processeur n’est qu’un i3. Comment 
exécuter ultraviewer dans proton ou 
n’importe quoi qui fonctionnera ?

R  : Je donne ma langue au chat. 
Avez-vous envisagé une alternative 

qui convienne bien à Linux comme 
Wayke ou Anydesk ? Tous les deux 
fonctionnent à merveille sur les deux OS.

Q  : Comment exécuter Gparted sur 
Ubuntu sans sudo ? Je voudrais for-

mater des cartes SD.

R  : Vous ne pouvez pas le faire, car 
il faut un accès avec root pour faire 

des opérations destructrices. « disques » 
ne fonctionne-t-il pas pour vous ?

Erik travaille dans l'informatique depuis 
plus de 30 ans. Il a vu la technologie aller 
et venir. De la réparation de disques durs 
de la taille d'une machine à laver avec 
multimètres et oscilloscopes, en passant 
par la pose de câbles, jusqu'au dimen-
sionnement de tours 3G, il l'a fait. 
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JJEEUUXX  UUBBUUNNTTUU
Écrit par Erik TToonniigghhtt  WWee  RRiioott

Site Web : 
https://tonightweriot.com/
Priix : 15 $ sur GOG / Itch.io

Aperçu : « tonight we riot (une émeute 
éclatera ce soir) présente une rixe de 
foule au sujet de la libération des ouvriers 
et pendant laquelle des cocktails molo-
tov sont lancés à des mecs en complet-
veston et des patrons fous ! »

et

« Dans une dystopie où des capitalistes 
richissimes contrôlent les élections, les 
médias et la vie des travailleurs, nous 
avons deux choix : l'accepter ou nous 
battre pour quelque chose de mieux. » 
[C'est ce que nous avons maintenant, 
non ???? - Erik] 

Tonight We Riot n'a pas qu'un seul 
héros. À la place, votre "person-

nage" est un mouvement de foule 
dont le bien-être détermine le succès 
de votre révolution. 

L'heure est venue de mettre notre 
costume de socialiste adulte et d'af-
fronter les flics !!

La première chose dont je voudrais 

parler, c'est le son. J'ai écouté l'intro 
jusqu'au bout et attendu que la mélo-
die se termine. Allez l'écouter ici : 
https://www.youtube.com/watch?
v=W9Lrw5OOn1Uv  La musique est ex-
cellente. Le genre synthwave transpose 
le grondement rétro en grondement 
rétro futuriste. Les bruitages du jeu 
sont présents et sont convenables, je 
suppose, mais je suggérerais que vous 
laissiez la musique allumée. (Pour être 
honnête, je m'attendais à Katyusha ou 
un truc dans le genre, et la musique 
était donc la surprise.)

Cela étant dit, c'est quoi Tonight 
We Riot ? C'est essentiellement un jeu 

de combat où vous êtes le porte-dra-
peau. Il me rappelle un peu « river city 
ranson », un autre jeu de combat pi-
xelisé. Vous vous déplacez de gauche 
à droite sur l'écran, tabassez tous les 
flics qui vous retardent et libérez les 
travailleurs. Après avoir libéré tous les 
travailleurs dans une section, vous au-
rez atteint la fin et les riches patrons 
se sauveront, terrorisés. Vous serez 
noté sur votre performance et le nom-
bre de vos suiveurs qui ont survécu. 
C'est cela la boucle principale du jeu. À 
chaque niveau, il y a de nouveaux en-
nemis et de nouvelles armes, pour que 
les choses restent intéressantes. Ce 
ne sont pas seulement la police et les 

riches qui sont vos ennemis. Le terrain 
peut être un adversaire aussi et il faut 
donc bien choisir votre chemin. Vous 
pouvez bouger ou détruire des objets 
à l'écran, c'est votre choix, mais il faut 
réaliser qu'une bonbonne de propane 
qui explose tuera tous ceux qui sont 
dans les parages. Votre progrès est 
mesuré sur une carte aérienne, à la 
Mario. Vous pouvez sauter un niveau à 
tout moment et aller directement au 
prochain.

C'est un jeu à un ou à deux joueurs. 
Vous et votre complice de crime ou 
compagnon révolutionnaire pouvez uti-
liser des armes et vos poings ainsi que 
des projectiles. De temps en temps, 
vous rencontrerez quelques briques 
ou cocktails Molotov utiles sur le che-
min. Vous pouvez gagner des armes, 
des choses comme des battes de base-
ball ou des grosses clés, en gardant 
vos suiveurs en vie. Cela étant dit, il 
vaut mieux que vous ne mouriez pas 
non plus. Vous avez la barre de santé 
et l'indicateur de type d'armes, comme 
d'habitude. Si vous mourez, un autre 
révolutionnaire prend votre place jus-
qu'à ce qu'il n'en reste aucun...

Les différentes armes sur chaque 

https://tonightweriot.com/
https://www.youtube.com/watch?v=W9Lrw5OOn1Uv
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côté ont des effets différents : par 
exemple, le gaz lacrymogène disper-
sera votre foule, et des balles les tue-
ront. Tout n'est pas statique pendant 
que vous vous déplacez de gauche à 
droite, des fourgonnettes remplies de 
policiers anti-émeute arriveront sur 
l'écran et des flics en descendront. 
Des canons à eau contreront vos atta-
ques à distance. Bon, même si c'est un 
jeu insolent, avec beaucoup de vio-
lence et de meurtres de flics, vous 
devez le prendre avec une pincée de 
sel. (Quand vous voudrez battre un 
chien, vous trouverez un bâton.)

Bien qu'il y ait une option pour jouer 
à ce jeu avec le clavier, je suggérerais 
de vous procurer un contrôleur, car il a 
été conçu autour d'un contrôleur. Il se 
veut un jeu de combat rapide, sur un 
chemin sans fin et c'est là où la 

manette de jeu brille. Ce n'est pas qu'il 
soit impossible de jouer au jeu avec le 
clavier, loin de là, mais la meilleure 
option est tout simplement d'appuyer 
de façon irréfléchie sur vos boutons, 
grands ou petits.

À mon avis, les graphismes sont 
une sorte de pot-pourri ; une partie du 
pixel art est superbe et une partie 
semble très paresseuse. Surtout les 
personnages. J'ai l'impression d'une ba-
nalité coincée entre des graphismes 8 
et 16-bit. Certaines étapes et certains 
véhicules sont vraiment éblouissants 
et d'autres ne sont pas aussi bons. À 
un moment quelconque, il y a même 
un chien qui se joint à votre cause. Ça 
aurait été spectaculaire s'il y avait da-
vantage de détails, mais, actuellement, 
le chien me rappelle Snoopy, mal des-
siné. Les actualités sont agréables et 

font progresser l'histoire pendant que 
vous jouez. Les présentateurs gras et 
d'autres personnages sont bien dessi-
nés.

Le jeu est exigeant et ne convient 
pas à ceux qui ont des TOC. Vous ne 
pouvez pas toujours sauver tous vos 
camarades. Bien que vous puissiez es-
sayer de le faire, je suggère que vous 
ne vous en inquiétiez pas trop ; les 
meurtres pixelisés et le chaos devraient 
faire partie du bruit de fond, pendant 
que vous jouissez du grabuge. C'est 
très divertissant, cependant, alors sortez 
vos euros capitalistes et achetez ce 
jeu. Faites-moi confiance, vous vous 
amuserez pendant les émeutes d'une 
façon ou d'une autre. *clin d'œil. J'ai la 
version GOG et tout à très bien fonc-
tionné comme attendu sous Ubuntu. 

Je touche du bois, mais jusqu'à pré-
sent, je n'ai eu aucun problème avec 
l'installeur GOG sur Ubuntu 14 à 18.

La question reste : vaut-il 15 $ ? Si 
vous habitez un pays où quinze dollars 
est quinze dollars, pourquoi pas ? Le 
truc c'est que, si vous êtes dans un 
autre pays où quinze dollars est deux 
cent dollars, alors peut-être pas. Es-
sayez de chercher un prix sur une base 
régionale.

Erik travaille dans l'informatique depuis 
plus de 30 ans. Il a vu la technologie aller 
et venir. De la réparation de disques durs 
de la taille d'une machine à laver avec 
multimètres et oscilloscopes, en passant 
par la pose de câbles, jusqu'au dimen-
sionnement de tours 3G, il l'a fait. 
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Alex Popescu
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Doug Bruce
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Eric Meddleton
George Smith
Henry D Mills
Hugo Sutherland
Jack
Joao Cantinho Lopes
John Andrews
John Malon
John Prigge
Jonathan Pienaar
JT
Kevin O'Brien
Lee Allen
Leo Paesen
Linda P
Mark Shuttleworth
Norman Phillips
Oscar Rivera
Paul Anderson

Paul Readovin
Rob Fitzgerald
Roy Milner
Scott Mack
Sony Varghese
Tom Bell
Tony
Vincent Jobard
Volker Bradley
William von Hagen
Taylor Conroy
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Ronald Eike
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Jon Loveless
Frank Dinger
Raymond Mccarthy
Daniel Rojo
Frits van Leeuwen
Peter Swentzel
Anthony Cooper
Dale Reisfield
Gavin Thompson
Brian Kelly
Ronald Eike
Michael Grugel

Glenn Nelson Le site actuel du Full Circle Magazine fut 
créé grâce à Lucas Westermann (Monsieur 
Command & Conquer) qui s'est attaqué à 
la reconstruction entière du site et des scripts 
à partir de zéro, pendant ses loisirs.

La page Patreon (Mécènes) existe pour aider à 
payer les frais du domaine et de l'héber-
gement. L'objectif annuel fut rapidement 
atteint grâce à ceux dont le nom figure sur 
cette page. L'argent contribue aussi à la 
nouvelle liste de diffusion que j'ai créé.

Parce que plusieurs personnes ont demandé 
une option PayPal (pour un don ponctuel), 
j'ai ajouté un bouton sur le côté droit du 
site Web.

De très sincères remerciements à tous ceux 
qui ont utilisé Patreon et le bouton PayPal. 
Leurs dons m'aident ÉNORMÉMENT.

https://www.patreon.com/
fullcirclemagazine

https://paypal.me/ronnietucker

https://donorbox.org/recurring-
monthly-donation

https://www.patreon.com/fullcirclemagazine
https://paypal.me/ronnietucker
https://donorbox.org/recurring-monthly-donation
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Date limite :
Dim. 6 septembre  2020.
Date de parution :
Vendr. 25 septembre 2020.

Format EPUB - Les éditions récentes du Full Circle comportent un 
lien vers le fichier epub sur la page de téléchargements. Si vous 
avez des problèmes, vous pouvez envoyer un courriel à : 
mobile@fullcirclemagazine.org

Issuu - Vous avez la possibilité de lire le Full Circle en ligne via 
Issuu : http://issuu.com/fullcirclemagazine. N'hésitez surtout pas à 
partager et à noter le FCM, pour aider à le faire connaître ainsi qu' 
Ubuntu Linux.

Magzster - Vous pouvez aussi lire le Full Circle online via 
Magzster : http://www.magzter.com/publishers/Full-Circle. N'hési-
tez surtout pas à partager et à noter le FCM, pour aider à le faire 
connaître ainsi qu'Ubuntu Linux.

Obtenir le Full Circle Magazine :

Pour les Actus hebdomadaires du Full Circle :
Vous pouvez vous tenir au courant des Actus hebdomadaires en 
utilisant le flux RSS :  http://fullcirclemagazine.org/feed/podcast

Ou, si vous êtes souvent en déplacement, vous pouvez obtenir les 
Actus hebdomadaires sur Stitcher Radio (Android/iOS/web) : 
http: www.stitcher.com/s?fid=85347&refid=stpr 

et sur TuneIn à : http://tunein.com/radio/Full-Circle-Weekly-News-
p855064/

FULL CIRCLE A BESOIN DE VOUS !
Un magazine n'en est pas un sans articles et Full Circle n'échappe pas à cette 
règle. Nous avons besoin de vos opinions, de vos bureaux et de vos histoires. 
Nous avons aussi besoin de critiques (jeux, applications et matériels), de 
tutoriels (sur K/X/Ubuntu), de tout ce que vous pourriez vouloir communiquer 
aux autres utilisateurs de *buntu. Envoyez vos articles à :

 articles@fullcirclemagazine.org

Nous sommes constamment à la recherche de nouveaux articles pour le Full Circle. Pour de l'aide 
et des conseils, veuillez consulter l'Official Full Circle Style Guide :
 http://url.fullcirclemagazine.org/75d471

Envoyez vos remarques ou vos expériences sous Linux à : letters@fullcirclemagazine.org

Les tests de matériels/logiciels doivent être envoyés à : reviews@fullcirclemagazine.org

Envoyez vos questions pour la rubrique Q&R à : questions@fullcirclemagazine.org

et les captures d'écran pour « Mon bureau » à : misc@fullcirclemagazine.org

Si vous avez des questions, visitez notre forum : fullcirclemagazine.org

Équipe Full Circle

Rédacteur en chef - Ronnie Tucker
ronnie@fullcirclemagazine.org

Webmaster - Lucas Westermann
admin@fullcirclemagazine.org

Correction et Relecture 
Mike Kennedy, Gord Campbell, 
Robert Orsino, Josh Hertel, Bert Jerred, Jim 
Dyer et Emily Gonyer

Remerciements à Canonical, aux nombreuses 
équipes de traduction dans le monde entier et à 
Thorsten Wilms pour le logo du FCM.

Pour la traduction française : 
http://www.fullcirclemag.fr

Pour nous envoyer vos articles en français 
pour l'édition française : 
webmaster@fullcirclemag.fr

Obtenir le Full Circle en français : http://www.fullcirclemag.fr
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